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Татьяна Юрьевна Соколова
AutoCAD 2009. Учебный курс

 
Введение

 
Постоянно растущий уровень компьютерных технологий, динамичное развитие про-

граммных и аппаратных средств влекут за собой бурный переход от традиционных методов
ведения проектно-конструкторских работ к использованию новых автоматизированных систем
разработки и выполнения конструкторской документации.

На сегодняшний день производство продукции мирового класса возможно только на
соответствующем оборудовании и с использованием современных средств автоматизации. Ни
одно предприятие, ведущее разработки сложных технических объектов, теперь не обходится
без использования компьютеров и мощного программного обеспечения, позволяющего гармо-
нично сочетать форму и содержание проекта, оптимизировать процесс разработки и выполне-
ния конструкторской документации при многократном использовании имеющихся данных.

Базовые графические системы обогащают, но не усложняют возможности творческого
поиска конструкторов, поскольку обладают высокотехнологичными и удобными, простыми в
обращении инструментами, при помощи которых в одном проекте реализуются замыслы целой
команды проектировщиков и требования заказчиков. На базе универсальных графических
систем разрабатываются автоматизированные рабочие места конструкторов, технологов, архи-
текторов, схемотехников и многих других разработчиков.

Новейшие компьютерные технологии предоставляют современные аппаратные, про-
граммные и информационные средства, реализующие автоматизацию инженерно-графических
работ. При этом предполагается обеспечение ввода, вывода, создания, хранения и обработки
моделей геометрических объектов и их изображений с помощью компьютера, а также наличие
средств моделирования геометрических объектов, их обработки и др.

В последнее время все больше утверждается оригинальный подход к автоматизации
конструкторской деятельности, в основе которого – создание трехмерных геометрических
представлений графических моделей изделий. Современный уровень развития компьютерных
технологий позволяет создавать пространственные модели объектов с практически неограни-
ченными возможностями, обеспечивая большую достоверность решения геометрических и
других задач для пространственной модели, что позволяет перейти на качественно новый уро-
вень разработки.

В настоящее время существует множество графических редакторов и программ геомет-
рического моделирования. Компания Autodesk – один из ведущих производителей систем
автоматизированного проектирования и программного обеспечения для конструкторов,
дизайнеров, архитекторов. Это крупнейший в мире поставщик программного обеспечения и
услуг для промышленного и гражданского строительства, машиностроения, геоинформатики,
цифровых средств передачи информации и беспроводной связи, обслуживающий 7 000 000
пользователей.

Система AutoCAD, разработанная этой компанией, является лидирующей в мире плат-
формой программного обеспечения систем автоматизированного проектирования (САПР),
предназначенной для профессионалов, которым требуется воплощать свои творческие
замыслы в реальные динамические проекты.

AutoCAD – программа с богатой и во многом уникальной историей. Впервые она увидела
свет в 1982 году под именем MicroCAD. Первая версия AutoCAD ознаменовала начало насто-
ящей революции в автоматизированном проектировании. Сегодня AutoCAD переводится на
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18 языков, ее используют в своей работе миллионы проектировщиков во всем мире на про-
цессорах в тысячи раз мощнее тех, которые были установлены на первых персональных ком-
пьютерах.

AutoCAD является постоянно развивающейся базовой средой проектирования, каждая
новая версия которой наследует все лучшее от предыдущих и направлена на решение следую-
щих основных задач: повышение производительности и эффективности работы пользователей;
обеспечение многократного использования имеющихся наработок; беспрепятственное сотруд-
ничество пользователей при проектировании; адаптация AutoCAD к индивидуальным потреб-
ностям разработчиков объектно-ориентированных задач.

Залог успеха Autodesk – мировое признание AutoCAD в качестве стандарта де-факто для
разработки продуктов и комплектующих, а также для документации.

Используя свою стратегию, направленную на помощь заказчикам в создании, органи-
зации и распространении цифровых конструкторских данных и в решении серьезных биз-
нес-проблем, Autodesk предлагает наиболее полный комплект интегрированных программ-
ных инструментов двумерного и трехмерного конструирования, что позволяет создавать более
качественные продукты, ускорять вывод изделий на рынок и добиваться максимальной нагляд-
ности проектов и максимально эффективного сотрудничества.

Благодаря выпуску AutoCAD 2009 компания Autodesk предлагает архитекторам, дизай-
нерам, инженерам и проектировщикам новый инструмент для еще более полного воплощения
их идей в реальность.
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От издательства

 
Ваши замечания, предложения и вопросы отправляйте по адресу электронной почты

dgurski@minsk.piter.com (издательство «Питер», компьютерная редакция).
Мы будем рады узнать ваше мнение!
На сайте издательства http://www.piter.com вы найдете подробную информацию о наших

книгах.

mailto:dgurski@minsk.piter.com
http://www.piter.com/
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Требования к системе

 
AutoCAD может работать как в автономном режиме, так и в локальной сети. Для эффек-

тивной работы AutoCAD 2009 под управлением операционной системы Windows необходимы
следующие программные и аппаратные средства:

• процессор Intel® Pentium® IV;
• операционные системы: Microsoft® Windows® XP Professional или Home Edition (пакет

обновлений SP1 или SP2), Windows XP Tablet PC Edition (SP2) или Windows 2000 (SP3
или SP4). Рекомендуется устанавливать и эксплуатировать AutoCAD либо на операционной
системе, локализованной на одном языке с программой, либо на англоязычной версии одной
из перечисленных систем;

• Microsoft® Internet Explorer 6.0 (пакет обновлений SP1 или более поздний);
• 512 Мбайт оперативной памяти;
• монитор VGA с разрешением не менее 1024 × 768 и поддержкой режима true color;
• 750 Мбайт свободного места на жестком диске для установки;
• привод компакт-дисков: любой (только для установки программы).
Требования к системе при использовании AutoCAD 2009 для концептуального проекти-

рования:
• процессор Intel® с тактовой частотой 3 ГГц и выше;
• Windows XP Professional (пакет обновлений SP2);
• не менее 2 Гбайт оперативной памяти;
• 2 Гбайт свободного места на жестком диске, не считая места, необходимого для уста-

новки программы;
• монитор с минимальным разрешением 1280 × 1024 и поддержкой режима true color;
• графический адаптер класса рабочих станций, снабженный не менее 128 Мбайт памяти

и поддерживающий технологию OpenGL.
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Запуск системы AutoCAD

 
Запуск AutoCAD осуществляется следующими способами:
• на Панели задач выберите из меню Start → Programs → Autodesk → AutoCAD 2009;
• на Рабочем столе Windows дважды щелкните на пиктограмме AutoCAD 2009.
При запуске AutoCAD предлагает создать новый неименованный рисунок. Можно либо

начать создавать в нем объекты, либо загрузить с диска один из уже имеющихся файлов.
При открытии ранее подготовленного имеющегося рисунка всем системным переменным

присваиваются значения, которые они имели в ходе последнего сеанса работы с ним. Это про-
исходит благодаря тому, что переменные сохраняются в файле вместе с рисунком.

Если же вы начинаете работу с нуля, следует предварительно задать ряд установок.
Обычно это делается автоматически с помощью Мастера подготовки Wizard Description.
AutoCAD позволяет менять установки и в ходе сеанса, если возникает такая необходимость.
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Начало работы

 
После запуска AutoCAD выводится диалоговое окно начала работы Startup (рис. 1.1).

Рис. 1.1. Диалоговое окно начала работы

В диалоговом окне Startup пользователю предлагается четыре кнопки, в зависимости от
выбора которых меняется содержимое диалогового окна:

Open a Drawing – для открытия ранее созданного чертежа. Позволяет выбрать из списка
один из рисунков, открывавшихся последними, и загрузить его в AutoCAD. Чтобы загрузить
файл, отсутствующий в списке, следует нажать кнопку обзора Browse…;

Start from Scratch – для создания чертежа, где устанавливаются только единицы измере-
ния в области Default Settings: британские (футы и дюймы) или метрические (миллиметры):

– Imperial (feet and inches) – создание нового рисунка, использующего британскую
систему единиц измерения, по шаблону acad.dwt. При этом область рисования, называемая
еще лимитами рисунка, устанавливается равной 12 × 9 дюймов;
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– Metric – создание нового рисунка, использующего метрическую систему единиц изме-
рения, по шаблону acadiso.dwt. При этом область рисования устанавливается равной 429 × 297
мм;

Use a Template – для создания чертежа по шаблону – документу, установки которого
используются как основа для нового рисунка. В области Select a Template: выбирается шаблон,
содержащий необходимые установки черчения. В списке перечисляются имена файлов шаб-
лонов с расширением DWT, которые найдены по стандартному пути, заданному в диалоговом
окне настроек Options. В шаблонах определяются различные параметры рисунка, в том числе
наборы специально созданных слоев, типов линий и видов;

Use a Wizard – вызов Мастера для установки параметров нового чертежа. В области
Select a Wizard: предлагается два режима автоматической настройки рабочей среды AutoCAD
– детальная подготовка Advanced Setup и быстрая подготовка Quick Setup:

– диалоговое окно детальной подготовки Advanced Setup позволяет выполнить полную
установку параметров рабочей среды AutoCAD: назначить единицы измерения длины Units
и угла Angle, задать начало отсчета угла Angle Measure и направление его измерения Angle
Direction, определить границы области рисунка Area;

– диалоговое окно быстрой подготовки Quick Setup позволяет выполнить быструю уста-
новку параметров рабочей среды AutoCAD: выбрать единицы измерения длины Units и опре-
делить границы области черчения Area.

Диалоговое окно начала работы Startup вызывается при каждой загрузке сеанса AutoCAD
только один раз. В дальнейшем для создания рисунков в уже запущенном сеансе AutoCAD
открывается диалоговое окно создания нового рисунка Create New Drawing.
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Подробнее о шаблоне

 
Установленный набор параметров сеанса можно сделать доступным и для рисунков,

создаваемых впоследствии. Для этого следует сохранить документ как шаблон. Шаблон обычно
представляет собой рисунок, не содержащий никаких графических объектов и используемый
только для хранения стандартных значений системных переменных.

Шаблоны (файлы с расширением DWT) – весьма удобное средство создания набора
рисунков с однотипными настройками. Можно использовать как шаблоны, поставляемые с
AutoCAD, так и созданные пользователем. Любой имеющийся рисунок можно сохранить в
качестве шаблона. В этом случае значения всех параметров настройки сохраняемого доку-
мента будут наследоваться всеми создаваемыми на его основе новыми рисунками.

Хотя в качестве шаблона подойдет любой рисунок, лучше всего подготовить набор стан-
дартных шаблонов, где представлены чаще всего используемые установки и базовые элементы:

• тип и точность представления единиц;
• лимиты рисунка;
• настройки режимов шага SNAP, сетки GRID и ортогонального режима ORTHO;
• организация слоев;
• основные надписи, рамки и логотипы;
• размерные и текстовые стили;
• типы и веса (толщины) линий.
Никакие изменения, вносимые в рисунок, созданный на основе шаблона, на сам шаблон

не распространяются.
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Вызов справочной системы

 

В любой момент работы с AutoCAD вы можете получить доступ к электронной доку-
ментации по программе. Для этого необходимо выбрать в падающем меню пункт Help. Аль-
тернативный вариант – нажать клавишу F1 на функциональной клавиатуре, ввести символ ?
в командной строке или щелкнуть на пиктограмме со значком вопроса на стандартной панели
инструментов.
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Открытие рисунков

 
Программа AutoCAD по умолчанию записывает внутреннее представление рисунка в

файл с расширением DWG. Кроме рисунка файл содержит ряд параметров, определяющих
значения переключателей режимов шага SNAP, сетки GRID, ортогонального режима ORTHO;
принятые единицы измерения и точность представления; границы рисунка; организацию
слоев; форматы и логотипы; размерные и текстовые стили; типы линий и т. п.

AutoCAD предлагает многооконную среду проектирования Multiple Design Environment
(MDE), которая допускает одновременное открытие нескольких чертежей. В одном сеансе
работы можно открывать неограниченное количество рисунков, не жертвуя при этом произ-
водительностью. Среда MDE позволяет перетаскивать объекты, копировать их свойства, такие
как цвет, слой, тип линии, из одного рисунка в другой. Она обеспечивает параллельную работу
с несколькими рисунками, не прерывая выполнения текущей команды и не нарушая последо-
вательности действий. Это существенно упрощает выполнение многих операций и повышает
эффективность работы.

Открыть существующий рисунок можно с помощью команды OPEN, которая вызыва-
ется из падающего меню File → Open… или щелчком на пиктограмме Open…CTRL+O на
стандартной панели инструментов.

После обращения к команде OPEN на экране AutoCAD появляется диалоговое окно
выбора файла Select File (рис. 1.2). Здесь можно выбрать имя файла из списка или ввести это
название в поле File name:.

Рис. 1.2. Диалоговое окно выбора файла
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При выделении в списке одного из файлов в области Preview появляется соответствую-
щий образец рисунка. Нажатие кнопки Views выводит список, изменяя параметры которого
пользователь может выбрать форму представления файлов, предлагаемых для открытия: спи-
сок, таблицу, образцы.

Режим открытия файлов – Open (Открыть), Open Read-Only (Открыть для чтения),
Partial Open (Открыть частично), Partial Open Read-Only (Открыть для чтения частично) –
устанавливается в списке при нажатии стрелки справа от кнопки Open. Частичное открытие
позволяет загружать только те объекты рисунка, которые принадлежат определенным слоям
или видовым экранам. Это оказывается полезным при работе с большими файлами.

Для открытия нескольких рисунков одновременно следует выбрать необходимые файлы
в диалоговом окне Select File, используя клавишу Shift или Ctrl.

Кроме того, рисунки можно открывать путем перетаскивания из Проводника Windows.
Для этого один или несколько выделенных в дереве Проводника файлов следует перетащить
с помощью мыши в любую часть окна AutoCAD, за исключением области рисунка, например
на командную строку или в ту часть панелей инструментов, которая не занята кнопками. Если
же перетащить один файл в область рисования уже открытого рисунка, то произойдет вставка
содержимого перетаскиваемого документа в текущий рисунок в качестве внешней ссылки.

Для открытия рисунка можно дважды щелкнуть на имени соответствующего файла в
Проводнике Windows, что приведет к автоматическому запуску AutoCAD. Если же в системе
уже ведется сеанс работы в AutoCAD, то рисунок откроется в нем.

В AutoCAD имеется специальное средство просмотра небольших фрагментов рисунков,
открытия файлов рисунков и их поиска. Его можно использовать для поиска файлов в струк-
туре папок на одном или нескольких дисках.

Для загрузки диалогового окна просмотра и поиска файлов Find, показанного на рис.
1.3, необходимо в диалоговом окне Select File последовательно щелкнуть на кнопках Tools →
Find….
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Рис. 1.3. Диалоговое окно просмотра и поиска файлов

На вкладке Name & Location диалогового окна Find указываются имя, расширение и
область поиска файла.

AutoCAD разрешает выполнять поиск файлов по датам их создания, пользуясь вкладкой
Date Modified диалогового окна Find (рис. 1.4). Здесь организуется поиск файлов, созданных
или измененных в период между двумя указанными датами либо за определенное количество
последних дней или месяцев. Имена найденных документов отображаются в нижней части
диалогового окна.

Рис. 1.4. Вкладка поиска файлов

Рисунки, созданные в AutoCAD любой предшествующей версии, открываются как любой
документ версии 2009 и автоматически преобразуются в новый формат.
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Создание рисунков

 
При создании рисунка могут использоваться различные стандарты. Иногда они дик-

туются государственными и отраслевыми стандартами или нормами предприятия, иногда –
требованиями заказчика. Ключевой момент как для непосредственных исполнителей, так и
для руководителей групп, контролирующих ход выполнения проекта, – грамотная подготовка
начальных параметров рисунка.

Рассмотрим в качестве примера архитектурный проект. Он может включать в себя мно-
жество разделов: планы этажей, схемы сетей водоснабжения, канализации, отопления, венти-
ляции и т. п. Обычно каждый раздел проекта разрабатывается в отдельном подразделении,
поэтому здесь остро встает проблема унификации. Наиболее грамотное ее решение – обеспе-
чение всех исполнителей файлами шаблонов, настроенными на используемую систему единиц
и содержащими стандартные рамку, основную надпись, слои и типы линий.

Не менее важно, какие стили используются для текстовых надписей, штрихования и нане-
сения размеров. Их также следует задавать заранее: это дает гарантию, что каждый проекти-
ровщик будет действовать без отклонения от оговоренных стандартов.

Следует ответственно подходить к выбору рабочего масштаба. Только четкое представ-
ление о том, как соотносятся единицы рисунка на экране и единицы чертежа, выводимого на
плоттер, позволяет правильно выбрать высоту текста для пояснительных надписей и размеров.

Хотя компоновка чертежа обычно производится на последних стадиях проектирования,
грамотное планирование на предварительных этапах позволяет избежать многих ошибок и
избавить персонал от излишних операций редактирования. При создании проекта работа, как
правило, ведется в пространстве модели (здесь объекты представляются в натуральную вели-
чину), а для компоновки чертежа выполняется переход в пространство листа, где ко всем гра-
фическим объектам, текстам, типам линий и размерам применяется необходимый масштаб-
ный коэффициент.

Все начальные установки рисунка могут быть сохранены в шаблоне для последующего
использования в других документах. В качестве шаблона могут применяться как рисунки,
поставляемые с AutoCAD, так и любые другие, в том числе созданные пользователем. Новый
рисунок наследует всю информацию из используемого шаблона. Имеется также возможность
запускать AutoCAD без шаблона.

Создать новый рисунок позволяет команда NEW, вызываемая из падающего меню File
→ New… или щелчком на пиктограмме QNew на стандартной панели инструментов.

После запуска команды необходимые настройки параметров рабочей среды AutoCAD
производятся в диалоговом окне создания нового рисунка Create New Drawing – рис. 1.5.
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Рис. 1.5. Диалоговое окно создания нового рисунка

При создании рисунка по простейшему шаблону используется пиктограмма Start from
Scratch. В данном режиме устанавливается британская или метрическая система единиц. Зна-
чения многих системных переменных, принятые по умолчанию, зависят от того, какая из двух
систем выбрана. Эти переменные управляют текстом, размерами, сеткой, режимами привязки,
а также устанавливают действующие по умолчанию тип линий и файл образцов штриховки:

• Imperial (feet and inches) – создается рисунок, использующий британскую систему еди-
ниц измерения (футы и дюймы), по шаблону acad.dwt. При этом область рисования, иначе
называемая лимитами рисунка, устанавливается равной 12 × 9 дюймов;

• Metric – создается рисунок, где используется метрическая система единиц измерения,
по шаблону acadiso.dwt. При этом устанавливается область рисования 429 × 297 мм.

Чтобы создать рисунок с использованием шаблона, необходимо в диалоговом окне Create
New Drawing щелкнуть на пиктограмме Use a Template и в списке Select a Template: указать
нужный шаблон (рис. 1.6).
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Рис. 1.6. Выбор шаблона рисунка

В AutoCAD имеется так называемый Мастер подготовки Wizard – служебное средство
для создания нового рисунка. С помощью Мастера подготовки можно, взяв за основу теку-
щий шаблон, модифицировать некоторые базовые установки. Например, пользователь может
автоматически настраивать масштабные коэффициенты для текста в зависимости от общих
размеров рисунка. Если рисунки крупные, выбирается большая высота символов, если мелкие
– меньшая; таким образом обеспечивается разборчивость текстовых надписей, когда рисунок
отображается на экране целиком.

Для вызова Мастера подготовки необходимо в диалоговом окне Create New Drawing
щелкнуть на пиктограмме Use a Wizard – откроется окно, показанное на рис. 1.7.



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

22

Рис. 1.7. Создание нового рисунка с помощью Мастера подготовки

Мастер быстрой подготовки QuickSetup (рис. 1.8) позволяет задать для нового рисунка
единицы измерения Units и область рисования Area. Поддерживаются следующие типы еди-
ниц для рисования и вычерчивания: десятичные – Decimal, инженерные – Engineering, архи-
тектурные – Architectural, дробные – Fractional, научные – Scientific.

Рис. 1.8. Диалоговое окно Мастера быстрой подготовки
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Указывая ширину Width и длину Length области рисования, пользователь тем самым
задает граничные пределы рисунка, так называемые лимиты. Именно лимитами определяется
размер чертежа, впоследствии выводимого на плоттер. После того как все параметры заданы,
Мастер быстрой подготовки запускает сеанс рисования в пространстве модели.

Мастер детальной подготовки Advanced Setup (рис. 1.9) позволяет задать для нового
рисунка тип линейных единиц измерения Units и способ измерения углов Angle, указать начало
отсчета угла Angle Measure и направление измерения угла Angle Direction, определить границы
области рисунка Area. В отличие от Мастера быстрой подготовки, который настраивает только
пространство модели, Мастер детальной подготовки воздействует как на пространство модели,
так и на пространство листа.

Рис. 1.9. Диалоговое окно Мастера детальной подготовки

Любая из установок, произведенных в начале рисования, в дальнейшем может быть изме-
нена.
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Определение границ рисунка

 
Команда LIMITS позволяет установить границы текущего рисунка в пространстве

модели и в пространстве листа. Она вызывается из падающего меню Format → Drawing Limits.
В AutoCAD границы рисунка выполняют две функции: определяют диапазон изменения коор-
динат точек и контролируют фрагмент рисунка, покрытый видимой координатной сеткой.

Границы рисунка – это пара двумерных точек в мировой системе координат: координаты
левого нижнего и правого верхнего углов, определяющие прямоугольную область. По оси Z
границы не устанавливаются.

Запросы команды LIMITS:
Reset Model space limits: – переустановка лимитов пространства модели
Specify lower left corner or [ON/OFF] <current>: – левый нижний угол
Specify upper right corner <current>: – правый верхний угол

где:
• ON – включается контроль соблюдения границ. При этом AutoCAD отвергает все

попытки ввести точки с координатами, выходящими за границы рисунка;
• OFF – отключается контроль соблюдения границ рисунка;
• <current> – текущее значение.
Если текущее значение границ рисунка вас устраивает, достаточно нажать клавишу Enter.
Лимиты должны полностью охватывать полномасштабную модель. Например, если ее

размеры 100 × 200 мм, значения лимитов должны слегка превышать эти цифры.
В пространстве листа лимиты обычно задают равными формату листа бумаги. Следова-

тельно, сетка (если она включена) покрывает при этом весь скомпонованный чертеж, включая
графические объекты, размерные элементы, основную надпись и т. п. Например, если фор-
мат листа равен 210 × 297 мм, следует установить десятичный формат единиц и определить
лимиты указанием точек 0,0 для левого нижнего угла прямоугольника и 210,297 – для правого
верхнего угла.

Если в пространстве листа отображаются поля листа или подложен заданный формат,
нельзя задать границы рисунка с помощью команды LIMITS. В этом случае лимиты вычисля-
ются и устанавливаются в зависимости от размеров выбранного листа. Включение и отключе-
ние отображения полей и разметки листа производятся на вкладке Display диалогового окна
Options.

В пространстве модели лимиты могут быть заданы при создании нового рисунка с помо-
щью Мастера быстрой подготовки или Мастера детальной подготовки.



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

25

 
Определение параметров сетки

 
Сеткой называется упорядоченная последовательность точек, покрывающих область

рисунка в пределах лимитов. Работа в режиме GRID подобна наложению на рисунок листа
бумаги в клетку. Использование сетки помогает выравнивать объекты и оценивать расстояние
между ними. Сетку можно включать и отключать в ходе выполнения других команд. На печать
она не выводится.

Включение сетки и определение ее частоты осуществляется на вкладке Snap and Grid диа-
логового окна режимов рисования Drafting Settings (рис. 1.10), которое загружается из пада-
ющего меню Tools → Drafting Settings… или при выборе пункта настройки Settings… кон-
текстного меню, вызываемого щелчком правой кнопки мыши на кнопке Grid Display в строке
состояния.

Рис. 1.10. Диалоговое окно определения параметров сетки и шага привязки

Сетка включается при установке флажка Grid On (F7). В области Grid spacing устанавли-
вается частота горизонтальных и вертикальных делений сетки, то есть шаг сетки по осям X и
Y. Это осуществляется в текстовых полях Grid X spacing: и Grid Y spacing: соответственно. В
поле Major line every: устанавливается шаг основной линии.
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• В области Grid behavior определяется режим сетки: Adaptive grid – настройка сетки,
Allow subdivision below grid spacing – разрешение дробления мельче шага сетки, Display grid
beyond Limits – показать сетку за лимитами, Follow Dynamic UCS – следовать динамической
ПСК.

При работе с рисунком включать и отключать сетку следует щелчком на кнопке Grid
Display в строке состояния или нажатием функциональной клавиши F7.

После зумирования рисунка для лучшего согласования с новым коэффициентом экран-
ного увеличения может потребоваться изменение частоты сетки.
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Определение шага привязки

 
В режиме шаговой привязки SNAP курсор может находиться только в определенных

точках согласно установленному значению шага и при этом движется не плавно, а скачкооб-
разно между узлами воображаемой сетки, как бы «прилипая» к ее узлам. Активность режима
шаговой привязки SNAP можно определить визуально, по скачкообразному движению кур-
сора на экране. Шаговая привязка обычно используется для точного указания точек с помо-
щью мыши. Интервал привязки задается отдельно по осям X и Y. Включение и отключение
режима шаговой привязки может производиться в ходе выполнения команды.

Шаг привязки не обязательно совпадает с частотой сетки. Сетку часто делают достаточно
редкой, используя ее исключительно для наглядности, а шаг привязки устанавливают мень-
шим. Допустимо и обратное: установка большего по сравнению с сеткой шага привязки.

Включение шаговой привязки SNAP и настройка ее параметров осуществляются на
вкладке Snap and Grid диалогового окна режимов рисования Drafting Settings, которое загру-
жается из падающего меню Tools → Drafting Settings… или при выборе пункта Settings… из
контекстного меню, вызываемого щелчком правой кнопки мыши на кнопке Snap Mode в строке
состояния (см. рис. 1.10).

Шаговая привязка включается при установке флажка Snap On (F9). В области Snap
spacing задается шаг привязки по горизонтали и вертикали. Это осуществляется в текстовых
полях Snap X spacing: и Snap Y spacing: соответственно.

Параметром Equal X and Y spacing устанавливается равный шаг по осям X и Y. В области
Polar spacing задается шаг полярной привязки.

Тип привязки устанавливается в области Snap type. Grid snap – шаговая привязка
(Rectangular snap – ортогональная, Isometric snap – изометрическая), PolarSnap – полярная
привязка.

При работе с рисунком включать и отключать шаговую привязку следует щелчком на
кнопке Snap Mode в строке состояния или нажатием функциональной клавиши F9.
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Совмещение шаговой привязки

с полярным отслеживанием
 

При использовании полярного отслеживания можно установить такой режим шаговой
привязки, в котором узлы располагаются только вдоль линий полярного отслеживания через
заданные интервалы.

Для настройки шаговой привязки на совместную работу с полярным отслеживанием
необходимо выбрать из падающего меню Tools → Drafting Settings… и затем на вкладке Snap
and Grid диалогового окна Drafting Settings в области Snap type отметить пункт полярной при-
вязки PolarSnap – см. рис. 1.10. Затем в области Polar spacing в текстовом поле Polar distance:
задать величину шага привязки.
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Установка изометрического

стиля сетки и шаговой привязки
 

Изометрический стиль сетки и шаговой привязки помогает строить двумерные рисунки,
представляющие трехмерные объекты (например, куб). Аксонометрия (в том числе и изомет-
рия) – это не что иное, как средство изображения трехмерных объектов на плоскости, то
есть имитация объема, а не трехмерная модель. Поэтому изометрические рисунки нельзя рас-
сматривать в перспективной проекции или под различными углами. Имитация трехмерности
достигается здесь за счет расположения объектов по трем изометрическим осям. При нулевом
угле поворота шаговой привязки направления изометрических осей следующие: 30, 90 и 150°.
Узлы сетки и шаговой привязки можно ориентировать вдоль левой, правой или верхней изо-
метрической плоскости (рис. 1.11); переключение между плоскостями осуществляется нажа-
тием функциональной клавиши F5 (или сочетания CTRL+E):

• левая: сетка и шаговая привязка ориентируются вдоль осей, направленных под углами
90 и 150°;

• правая: сетка и шаговая привязка ориентируются вдоль осей, направленных под углами
90 и 30°;

• верхняя: сетка и шаговая привязка ориентируются вдоль осей, направленных под
углами 30 и 150°.

Рис. 1.11. Оси изометрической сетки привязки

При выборе изометрического стиля шаговая привязка, сетка и указатель мыши в виде
перекрестья поворачиваются соответственно выбранным изометрическим осям. При опреде-
ленных условиях в AutoCAD допускается указание только тех точек, которые лежат в одной
из изометрических плоскостей. Например, когда включен ортогональный режим ORTHO, ука-
зываемые при рисовании точки располагаются в текущей изометрической плоскости. Таким
образом, можно вначале нарисовать верхнюю плоскость модели, затем, переключившись на
левую плоскость, построить одну из сторон модели, а после этого завершить построение,
выбрав правую плоскость.

Для включения изометрии необходимо выбрать из падающего меню Tools → Drafting
Settings… и далее на вкладке Snap and Grid диалогового окна Drafting Settings в области Snap
type отметить пункт Isometric snap – см. рис. 1.10.
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Определение формата единиц

 
Размеры каждого из создаваемых в AutoCAD объектов задаются в условных единицах

измерения. Соответствие единиц AutoCAD и единиц существующих метрических систем уста-
навливается перед рисованием. Так, в одном рисунке единица может соответствовать одному
миллиметру, в другом – одному дюйму и т. д. Заданные значения определяют интерпретацию
вводимых координат и углов, а также вид отображаемых координат и размеров.

Тип и точность представления единиц назначают в диалоговом окне определения фор-
матов единиц Drawing Units, показанном на рис. 1.12. Оно вызывается из падающего меню
Format → Units…. В области Length устанавливаются формат Type: и точность Precision: линей-
ных единиц измерения, в области Angle – формат Type: и точность Precision: угловых единиц.
Параметр Clockwise определяет отсчет по часовой стрелке.

Рис. 1.12. Диалоговое окно определения форматов единиц

Для измерения расстояний предлагаются следующие форматы единиц:
• Architectural – архитектурные;
• Decimal – десятичные;
• Engineering – инженерные;
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• Fractional – дробные;
• Scientific – научные.
В техническом и архитектурном форматах значения чисел записываются в футах и дюй-

мах; при этом предполагается, что условная единица составляет один дюйм.
Для измерения угловых величин предлагаются следующие форматы единиц:
• Decimal Degrees – десятичные градусы;
• Deg/Min/Sec – градусы/минуты/секунды;
• Grads – грады;
• Radians – радианы;
• Surveyor's Units – топографические единицы.
Для указания нулевого угла необходимо щелкнуть на кнопке Direction…. Появляется

диалоговое окно выбора направления Direction Control – рис. 1.13.

Рис. 1.13. Диалоговое окно выбора направления

Нулевым называется направление, относительно которого AutoCAD измеряет углы. По
умолчанию таковым считается направление вправо от исходной точки.

Направление отсчета задается при помощи кнопок East – восток, North – север, West
– запад, South – юг или Other – другое. При выборе последней открывается доступ к кнопке
Angle:, с помощью которой задается угол путем указания двух точек в графической зоне экрана
или в текстовом поле, куда вводится числовое значение угла.
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Сохранение рисунков

 

Команда сохранения рисунка QSAVE вызывается из падающего меню File → Save
или щелчком на пиктограмме Save CTRL+S на стандартной панели инструментов. Команда
QSAVE используется в тех случаях, когда уже существующий рисунок сохраняется без изме-
нения его имени. Если рисунок новый и его имя не определено, то QSAVE действует так же,
как команда SAVEAS.

Команды SAVE и SAVEAS предназначены для сохранения рисунка под другим именем.
Команда SAVE может вызываться только из командной строки, а SAVEAS – из падающего
меню File → Save As…. В обоих случаях имя документа задается в поле File name: диалогового
окна Save Drawing As – рис. 1.14.

Рис. 1.14. Диалоговое окно сохранения рисунка

Предыдущей копии рисунка на диске присваивается расширение BAK вместо DWG. Все
предыдущие BAK-файлы с данным именем удаляются. Обновленный рисунок записывается с
расширением DWG. Если при указании имени файла оказывается, что рисунок с таким назва-
нием уже существует, выдается предупреждение и предоставляется возможность перезаписать
файл или ввести другое имя.

Любой рисунок можно сохранить как шаблон. Для этого в раскрывающемся списке Files
of type: диалогового окна Save Drawing As необходимо выбрать пункт AutoCAD Drawing
Template (*.dwt).

Чтобы обеспечить автоматическое сохранение рисунка через заданные интервалы вре-
мени, следует использовать системную переменную SAVETIME или вкладку Open and Save
диалогового окна Options. Оно вызывается из падающего меню Tools → Options…. В послед-
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нем случае необходимо поставить флажок автосохранения Automatic save в области File Safety
Precautions и установить значение интервала в минутах между автосохранениями в поле
Minutes between saves.
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Получение твердой копии рисунка

 
Распечатка чертежа – последний этап при работе с рисунком. Перед выводом рисунка

на печать необходимо его скомпоновать, то есть определить, какие виды должны быть вычер-
чены. Работа над рисунком ведется на разных этапах либо в пространстве модели, либо в про-
странстве листа. Пространство модели предназначено для создания модели – изображения в
реальном масштабе. Пространство листа представляет собой аналог листа бумаги, на кото-
ром производится создание и размещение видов перед вычерчиванием.

Как в пространстве модели, так и в пространстве листа может быть один или несколько
видовых экранов, на которых представлены различные виды модели. Компоновка чертежа, по
сути дела, представляет собой процесс создания и размещения таких экранов. По завершении
компоновки чертеж выводится на принтер или плоттер.

Перед выводом рисунка на плоттер можно предварительно просмотреть, как он будет
размещаться на листе бумаги. Для этого используется команда предварительного просмотра
PREVIEW, вызываемая из падающего меню File → Plot Preview или щелчком на пиктограмме
Plot Preview на стандартной панели инструментов. При этом автоматически включается изме-
нение масштаба изображения в режиме реального времени для просмотра мелких деталей чер-
тежа. Для изменения режима масштаба изображения, вывода на плоттер, использования пано-
рамирования или выхода из предварительного просмотра используется контекстное меню (рис.
1.15), которое вызывается в ответ на щелчок правой кнопкой мыши.

Рис. 1.15. Контекстное меню

Все установки вывода рисунка на плоттер осуществляются в диалоговом окне Plot –
Model (рис. 1.16). Это окно загружается командой PLOT, вызываемой из падающего меню File
→ Plot… или щелчком на пиктограмме Plot… (CTRL+P) на стандартной панели инструментов.
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Рис. 1.16. Диалоговое окно вывода на печать пространства модели

В диалоговом окне Plot – Model делаются следующие назначения.
• В области Page setup устанавливается набор параметров листа. Кнопкой Add… откры-

вается диалоговое окно добавления набора параметров листа.
• В области Printer/plotter устанавливаются параметры:
– из списка Name: выбирается устройство вывода;
– кнопка Properties… загружает редактор параметров плоттера;
– установкой флажка Plot to file назначается печать в файл.
• В области Paper size определяется формат.
• В области Number of copies устанавливается количество экземпляров.
• В области Plot area устанавливается печатаемая область: Display – экран, Limits –

лимиты, Window – область, выбранная рамкой.
• В области Plot offset (origin set to printable area) определяется смещение печатаемой

области по X и Y, а также центрированность.
• В области Plot scale определяется масштаб печати и веса линий:
– Fit to paper – вписать;
– Scale: – масштаб;
– Scale lineweights – масштабировать веса линий.
• В области Plot style table (pen assignments) определяется таблица стилей печати.
• В области видовых экранов с раскрашиванием Shaded viewport options определяется:
– Shade plot – способ вывода (как на экране, каркас, скрытие линий; 3D-скрытый, 3D-кар-

кас, концептуальный, реалистичный; тонирование, черновое, низкое, среднее, высокое, пре-
зентационное);

– Quality – качество (черновое, просмотр, нормальное, презентационное, максимум,
пользовательское).
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• В области Plot options определяются параметры печати:
– Plot in background – печатать в фоновом режиме;
– Plot object lineweights – учитывать веса линий;
– Plot with plot styles – учитывать стили печати;
– Plot paperspace last – объекты листа последними;
– Hide paperspace objects – скрывать объекты листа;
– Plot stamp on – включить штемпель;
– Save changes to layout – сохранить параметры.
• В области Drawing orientation определяется ориентация чертежа:
– Portrait – книжная;
– Landscape – альбомная;
– Plot upside-down – перевернутая.
• Кнопка Preview… загружает окно предварительного просмотра.
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Выход из AutoCAD

 
Для выхода из AutoCAD используется команда QUIT, которая вызывается из падающего

меню File → Exit CTRL+Q.
Команда позволяет сохранить или проигнорировать сделанные в рисунке изменения и

выйти из AutoCAD. Если все выполненные изменения сохранены, при выходе из программы не
появится никаких дополнительных сообщений. В противном случае на экран будет выведено
диалоговое окно AutoCAD (рис. 1.17), предлагающее пользователю выбор: сохранить измене-
ния, отказаться от них или продолжить сеанс работы. Если текущему рисунку не было присво-
ено имя и вы хотите его сохранить, откроется диалоговое окно Save Drawing As – см. рис. 1.14.

Рис. 1.17. Диалоговое окно сохранения изменений в рисунке
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Глава 2

Пользовательский интерфейс AutoCAD
 

Падающие меню
Панели инструментов
Стандартная панель инструментов
Панель стилей
Панель рабочих пространств
Панель слоев
Панель свойств объектов
Строка состояния
Окно командных строк
Текстовое окно
Экранное меню
Функциональные клавиши
Контекстное меню
Инструментальные палитры
Центр управления AutoCAD DesignCenter
Просмотр и поиск содержимого

На рис. 2.1. показан классический рабочий стол AutoCAD для Windows.

Рис. 2.1. Рабочий стол AutoCAD

В данный рабочий стол включены:
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• падающие меню Menu Browser – меню, появляющееся при щелчке кнопкой мыши на
кнопке A в верхнем левом углу окна программы (рис. 2.2);

• необязательные панели инструментов:
– стандартная панель Standard и панель стилей Styles – верхняя строка окна программы;
– панель рабочих пространств Workspaces, слоев Layers и свойств Properties – вторая

строка;
– панель рисования Draw, а также редактирования Modify – столбцы слева и справа;
– инструментальная палитра Tool Palettes – в правой части окна приложения;
• строка состояния – строка внизу окна программы;
• окно командных строк – выше строки состояния;
• графическое поле, занимающее остальную часть рабочего стола.

Рис. 2.2. Падающее меню
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Падающие меню

 
Строка падающих меню может быть изменена путем добавления либо удаления тех или

иных пунктов. Для этого необходимо выбрать в падающем меню пункты Tools → Customize →
Interface…, в появившемся диалоговом окне настройки интерфейса пользователя Customize
User Interface на вкладке Customize, в области Customizatios in All CUI Files раскрыть пункт
Menus (рис. 2.3). Далее установить указатель мыши на один из пунктов меню и, нажав правую
кнопку мыши, вызвать контекстное меню, в котором выбрать соответствующий пункт для уда-
ления имеющихся или создания новых падающих меню.

Рис. 2.3. Диалоговое окно адаптации меню

Строка падающих меню по умолчанию содержит следующие пункты:
• File – команды работы с файлами: создание, открытие, сохранение, публикация в

Интернете, печать, экспорт файлов в другие форматы, а также диспетчеры параметров листов,
плоттеров, стилей печати и пр.;

• Edit – инструменты для редактирования частей графического поля рабочего стола про-
граммы, работы с буфером обмена и пр.;

• View – управление экраном, зумирование, панорамирование, установка трехмерной
точки зрения, создание видовых экранов и именованных видов, установка визуальных стилей,
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тонирование, анимация траектории перемещения, установка необходимых панелей инструмен-
тов;

• Insert – команды вставки блоков, внешних объектов, объектов других приложений;
• Format – команды работы со слоями и их инструментами; цветом, типами линий; управ-

ление стилями текста, размеров, мультилиний, таблиц; видом маркера точки, установки еди-
ниц измерения, границ чертежа;

• Tools – управление рабочими пространствами; палитрами; установка порядка про-
рисовки объектов и получение сведений о них; работа с блоками и их атрибутами; работа
с языком AutoLISP; работа с пользовательской системой координат; настройка стандартов
оформления; управление Мастерами (публикации в Интернете, установки плоттеров, создания
таблиц стилей печати, цветозависимых стилей печати, компоновки листа, создания подшивки,
импорта параметров печати); установка параметров черчения и привязок с помощью диалого-
вых окон и пр.;

• Draw – команды двумерного и трехмерного рисования;
• Dimension – команды простановки размеров и управления параметрами размерных сти-

лей;
• Modify – команды редактирования элементов чертежа;
• Window – многооконный режим работы с чертежами;
• Help – вывод на экран системы гипертекстовых подсказок.
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Панели инструментов

 
Команды AutoCAD на панелях инструментов представлены в виде пиктограмм. Если

задержать указатель мыши на пиктограмме, рядом с ней появляется название соответствую-
щей команды, помещенное в маленький прямоугольник.

Если в правом нижнем углу пиктограммы изображен маленький черный треугольник,
это значит, что она содержит подменю с набором родственных команд. Для вызова подменю
необходимо на некоторое время задержать на пиктограмме указатель мыши, нажав ее левую
кнопку.

Панели инструментов могут быть плавающими (float) или закрепленными (dock), с фик-
сированным местоположением. Допускаются изменения размеров плавающих панелей, а также
их перемещение по графическому полю (рис. 2.4). Плавающую панель можно сделать закреп-
ленной, перетащив ее с помощью мыши за пределы графического поля. И наоборот, как только
закрепленная панель попадает в область графического поля, она превращается в плавающую.

Рис. 2.4. Плавающая панель инструментов

При необходимости требуемую панель инструментов можно вывести на рабочий стол,
щелкнув левой кнопкой мыши на ее имени в списке контекстного меню. Для получения этого
контекстного меню необходимо щелкнуть правой кнопкой мыши, установив ее указатель на
любую пиктограмму панелей инструментов (рис. 2.5).



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

43



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

44

Рис. 2.5. Список панелей инструментов

Для удаления панели инструментов необходимо сделать ее плавающей, если она закреп-
лена, и щелкнуть на кнопке закрытия, расположенной в правом верхнем углу заголовка панели.

Если набор необходимых панелей и окон упорядочен на рабочем столе, во избежание
их случайного перемещения или удаления пользователь может зафиксировать их положение.
Для этого следует вызвать контекстное меню щелчком правой кнопки мыши на инструменте,
изображающем замочек в правом углу строки состояния, и зафиксировать положение панелей:

• Floating Toolbars/Panels – плавающие панели инструментов;
• Docked Toolbars/Panels – закрепленные панели инструментов;
• Floating Windows – плавающие окна;
• Docked Windows – закрепленные окна;
• All – все инструменты: Locked – заблокированы, Unlocked – разблокированы;
• Help – справка.
Чтобы временно разблокировать панели инструментов, необходимо удерживать нажатой

клавишу Ctrl.
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Стандартная панель инструментов

 
Стандартная панель Standard показана на рис. 2.6.

Рис. 2.6. Стандартная панель инструментов

Она содержит следующие инструменты:

QNew – создание нового файла рисунка;

Open… (Ctrl+О) – загрузка существующего файла;

Save (Ctrl+S) – сохранение текущего файла;

Plot… (Ctrl+P) – вывод рисунка на плоттер, принтер или в файл;

Plot Preview – предварительный просмотр чертежа перед выводом на печать, позволяю-
щий увидеть размещение чертежа на листе бумаги;

Publish… – публикация листов чертежа в формате файла Design Web Format (DWF),
загрузка диалогового окна Publish;

3DDWF – экспорт трехмерной модели в формате файла Design Web Format (DWF);

Cut (Ctrl+X) – копирование объектов в буфер обмена с удалением их из рисунка;
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Copy (Ctrl+C) – копирование выбранных элементов чертежа в буфер Windows без удале-
ния их из исходного документа;

Paste (Ctrl+V) – вставка данных из буфера Windows;

Match Properties – копирование свойств заданного объекта другому объекту;

Block Editor – редактирование блоков;

Undo (Ctrl+Z) – отмена последнего действия;

Redo (Ctrl+Y) – восстановление только что отмененного действия;

Pan Realtime – перемещение изображения на текущем видовом экране в режиме реаль-
ного времени;

Zoom Realtime – увеличение или уменьшение видимого размера объектов на текущем
видовом экране в режиме реального времени;

Подменю Zoom – раскрывающийся набор инструментов, в котором можно задать раз-
личные способы увеличения и уменьшения видимого размера объектов на текущем видовом
экране;

Zoom Previous – возврат к показу предыдущего вида;

Properties (Ctrl+1) – загрузка палитры управления свойствами объектов;
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DesignCenter (Ctrl+2) – диалоговый интерфейс, позволяющий быстро находить, просмат-
ривать, вызывать, переносить в текущий рисунок ранее созданные рисунки, управлять вхожде-
ниями блоков, внешними ссылками и другими элементами рисунков, такими как слои, листы
и текстовые стили;

Tool Palettes Window (Ctrl+3) – инструментальные палитры в виде отдельных вкладок
специального окна, которые служат эффективным средством хранения/вставки блоков и штри-
ховки. Палитры могут содержать инструменты, предоставленные сторонними разработчиками;

Sheet Set Manager (Ctrl+4) – диспетчер подшивок наборов листов, позволяющий органи-
зовать размещение пакетов листов в зависимости от типа чертежей и с возможностью эффек-
тивного создания, управления и совместного использования наборов логически связанных
рисунков;

Markup Set Manager (Ctrl+7) – диспетчер наборов пометок, позволяющий организовать
работу с рисунками формата DWF;

QuickCalc (Ctrl+8) – калькулятор;

Help – вызов справочной системы.
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Панель стилей

 
Панель стилей Styles, показанная на рис. 2.7, предназначена для создания новых тексто-

вых, размерных и табличных стилей.

Рис. 2.7. Панель стилей

Панель содержит следующие инструменты:

Text Style… – создание новых и редактирование имеющихся текстовых стилей;

Dimension Style… – создание новых и редактирование имеющихся размерных стилей;

Table Style… – создание новых и редактирование имеющихся табличных стилей;

Multileader Style… – создание новых и редактирование имеющихся стилей линий-выно-
сок.
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Панель рабочих пространств

 
Панель Workspaces, показанная на рис. 2.8, позволяет задавать параметры рабочих про-

странств.

Рис. 2.8. Панель рабочих пространств

Рабочие пространства включают только необходимые наборы меню, инструментальные
панели и палитры, сгруппированные и упорядоченные соответственно решаемой задаче. Эле-
менты интерфейса, не являющиеся необходимыми для решения текущей задачи, скрываются,
максимально освобождая область экрана, доступную для работы.

В AutoCAD определены следующие рабочие пространства:
• 2D Drafting & Annotation – двумерное моделирование (рис. 2.9);

Рис. 2.9. Рабочее пространство для двумерного моделирования

• 3D Modeling – трехмерное моделирование (рис. 2.10);
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Рис. 2.10. Рабочее пространство для трехмерного моделирования

• AutoCAD Classic – классический AutoCAD (см. рис. 2.1).
Помимо возможности установить рабочее пространство, в панель Workspaces включены

следующие пункты:
• Save Current As… – открытие диалогового окна Save Workspace, позволяющего сохра-

нить текущее рабочее пространство;
• Workspace settings… – открытие диалогового окна Workspace Settings, позволяющего

настроить текущие параметры рабочего пространства для последующего использования;
• Customize… – открытие диалогового окна Customize User Interface, позволяющего осу-

ществить настройки интерфейса пользователя.
А также панель Workspaces содержит следующие инструменты:

Workspace Settings… – открытие диалогового окна Workspace Settings, позволяющего
настроить текущие параметры рабочего пространства для последующего использования;

My Workspace – возвращение имени текущего рабочего пространства в интерфейс
командной строки и установление этого пространства текущим.

Рабочее пространство 3D Modeling включает новый пульт управления, обеспечивающий
удобный доступ к новым функциям трехмерного моделирования. В области рисования отоб-
ражается цвет фона, наземная плоскость или рабочая поверхность и новая прямоугольная
сетка, что улучшает трехмерную визуализацию и облегчает создание пространственных моде-
лей. Новый трехмерный курсор обеспечивает указание направления ПСК. Вкладки Model и
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Lauout заменены кнопками в строке состояния, благодаря чему расширена область рисования.
На режим отображения вкладок можно переключиться, щелкнув правой кнопкой мыши на
кнопке Model или Lauout.
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Панель слоев

 
Панель слоев Layers, показанная на рис. 2.11, обеспечивает работу со слоями.

Рис. 2.11. Панель слоев

В нее входят следующие инструменты:

Layer Properties Manager – вызов Диспетчера свойств слоев Layer Properties Manager;

Layer Control – раскрывающийся список управления слоями. Каждая строка содержит
пиктограммы управления свойствами слоя или отображения его свойств, а также его имя.
Ниже перечисляются эти пиктограммы (слева направо):

– Turn a layer On or Off – включение/отключение слоя;
– Freeze or thaw in ALL viewports – замораживание/размораживание на всех видовых

экранах;
– Freeze or thaw in current viewport – замораживание/размораживание на текущем видо-

вом экране;
– Lock or Unlock a layer – блокирование/разблокирование слоя;
– Color of layer – цвет слоя;
– Layer Control – имя слоя.

Make Object's Layer Current – установка текущего слоя в соответствии со слоем выбран-
ного примитива;

Layer Previous – возврат к предыдущему состоянию слоев;

Layer States Manager – загрузка диалогового окна Layer States Manager.
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Панель свойств объектов

 
Панель свойств объектов Properties, показанная на рис. 2.12, предназначена для работы

с цветом, типом и весом линий.

Рис. 2.12. Панель свойств объектов

В нее входят следующие инструменты:

Color Control – раскрывающийся список установки текущего цвета, а также изменения
цвета выбранных объектов;

Line Type Control – раскрывающийся список установки текущего типа линии, а также
изменения типа линии для выбранных объектов;

Line Weight Control – раскрывающийся список установки текущего веса (толщины)
линии, а также изменения толщины линий выбранных объектов;

Plot Styles Control – раскрывающийся список установки стилей печати. Здесь можно
изменять внешний вид вычерчиваемого на плоттере рисунка.

В стилях печати при необходимости переопределяются цвета, типы и веса (толщины)
линий объектов. Кроме этого, имеется возможность указывать используемые при печати стили
концов линий, соединений и заполнений, а также различные выходные эффекты – размывание,
оттенки серого, присвоения перьев и интенсивность. Манипулируя стилями печати, можно
получить на бумаге различные варианты одного и того же рисунка. Допускается применение
стилей печати к объектам или слоям.
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Строка состояния

 
Строка состояния (рис. 2.13) расположена в нижней части рабочего стола.

Рис. 2.13. Строка состояния

Она содержит текущие координаты курсора, а также кнопки включения/выключения
режимов черчения:

Snap Mode – включение и выключение шаговой привязки курсора;

Grid Display – включение и выключение отображения сетки;

Ortho Mode – включение и выключение ортогонального режима;

Polar Tracking – включение и выключение режима полярного отслеживания;

Object Snap – включение и выключение режимов объектной привязки;

Object Snap Tracking – включение и выключение режима отслеживания при объектной
привязке;

Allow/Disallow Dynamic UCS – включение и выключение динамической пользователь-
ской системы координат;

Dynamic Input – включение и выключение динамического ввода;
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Show/Hide Lineweight – включение и выключение режима отображения линий в соответ-
ствии с весами (толщинами);

Quick Properties – включение и выключение свойств объектов;

Model or Paper space – переключение из пространства модели в пространство листа;

Quick View Layouts – включение и выключение просмотра листов;

Quick View Drawins – включение и выключение просмотра рисунков;

Pan – панорамирование рисунка;

Zoom – зумирование рисунка;

SteeringWheel – включение инструмента Wheel;

ShowMotion – включение инструмента Motion.

Отображение кнопок включения/выключения режимов черчения в строке состояния
устанавливается в контекстном меню (рис. 2.14). Для этого необходимо щелкнуть левой или
правой кнопкой на находящемся в правом углу строки состояния инструменте Status Bar menu
с изображением стрелки, направленной вниз.
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Рис. 2.14. Контекстное меню настройки строки состояния

Команда Tray Settings… открывает диалоговое окно Tray Settings (рис. 2.15), позволяю-
щее произвести настройку области уведомлений:

• Display icons from services – показывать значки служб;
• Display notifications from services – показывать уведомления от служб:
– Display time – время отображения;
– Display until closed – до явного закрытия.

Рис. 2.15. Диалоговое окно настройки области уведомлений
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Окно командных строк

 
Окно командных строк обычно расположено над строкой состояния; оно служит для

ввода команд и вывода подсказок и сообщений AutoCAD. Размеры окна, а следовательно,
количество выводимых строк протокола можно изменять. При наличии в окне команд более
одной строки перемещение по строкам осуществляется с помощью полосы прокрутки.

По умолчанию окно команд закреплено и равно по ширине окну AutoCAD (рис. 2.16).
Если текстовая строка не помещается в окне, ее полное содержимое выводится в рамке вблизи
командной строки.

Рис. 2.16. Закрепленное окно командных строк

Изменить высоту окна можно с помощью разделительной полосы, находящейся в его
верхней части (если оно закреплено внизу) или в нижней (если оно закреплено вверху). Чтобы
изменить размер, следует захватить разделительную полосу с помощью мыши и «отбуксиро-
вать» ее до требуемой высоты.

Окно может быть как закрепленным, так и плавающим. Закрепление отменяется путем
выбора рамки окна в любом месте и последующей буксировки за пределы зоны закрепления
до тех пор, пока граница окна не примет вид широкой контурной линии. Если отпустить окно
в этот момент, оно станет плавающим и приобретет размер, который имело до закрепления.
Плавающее окно может быть перемещено в любую позицию экрана; при этом пользователю
разрешено изменять его ширину и высоту (рис. 2.17).

Рис. 2.17. Плавающее окно командных строк

Закрепляется окно команд путем «буксировки» к верхней или нижней зоне закрепления
окна AutoCAD.

В окне командных строк можно прокручивать текст, выполнять его редактирование и
повторно вводить команды. Для этого используются стандартные клавиши: ↑, ↓, ←, →, Insert,
Delete, Home, End, Page Up, Page Down, Backspace.

При повторении ранее введенных команд удобно воспользоваться комбинацией клавиш
Ctrl+C, чтобы копировать выделенный текст в буфер обмена, и Ctrl+V, чтобы вставить содер-
жимое буфера в текстовое окно или окно команд.

Щелчок правой кнопкой мыши в области окна командных строк или текстового окна
AutoCAD вызывает контекстное меню, куда входят шесть последних использованных команд,
функции копирования выделенного текста или всего протокола команд, вставки текста, а также
вызова диалогового окна настройки Options.
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Текстовое окно

 
Просмотреть большую часть протокола команд – так называемую историю команд

(command history) – можно, переключившись в текстовое окно, показанное на рис. 2.18. Оно
вызывается нажатием функциональной клавиши F2 или командой TEXTSCR, а также из пада-
ющего меню View → Display → Text Window F2.

Рис. 2.18. Текстовое окно

Текстовое окно подобно окну команд: в нем также можно вводить команды, наблю-
дать подсказки и сообщения, выдаваемые AutoCAD. Для перемещения по окну используются
полоса прокрутки или клавиши ↑, ↓, ←, →, Page Up и пр.

Содержимое текстового окна предназначено только для чтения и не подлежит измене-
нию. Но протокол команд можно копировать для последующей вставки в командную строку
или текстовый редактор.
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Экранное меню

 
В AutoCAD 2009 сохраняется возможность отображения экранного меню. Его включе-

ние и отключение выполняются на вкладке Display диалогового окна Options, загружаемого из
падающего меню Tools → Options…. Достаточно установить или снять флажок Display screen
menu в области Window Elements.

Экранное меню AutoCAD имеет иерархическую структуру. Используя переходы в раз-
личные подменю, можно передвигаться по дереву меню. Для перехода к корню дерева служит
верхняя строка экранного меню, где всегда находится слово AutoCAD.
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Функциональные клавиши

 
Для удобной работы с системой сохраняется возможность использования функциональ-

ных клавиш:
• F1 – вызов справочной системы AutoCAD;
• F2 – переключение между текстовым и графическим окнами;
• F3 или Ctrl+F – включение/отключение текущих режимов объектной привязки OSNAP;
• F4 – переключение системной переменной TABMODE;
• F5 или Ctrl+E – циклическое переключение изометрических плоскостей;
• F6 или Ctrl+D – включение/отключение динамических ПСК, переключение системной

переменной UCSDETECT;
• F7 или Ctrl+G – включение/отключение отображения сетки GRID, переключение

системной переменной GRIDMODE;
• F8 или Ctrl+L – включение/отключение ортогонального режима построений ORTHO,

переключение системной переменной ORTHOMODE;
• F9 или Ctrl+B – включение/отключение шаговой привязки SNAP, переключение

системной переменной SNAPMODE;
• F10 – включение/отключение режима полярного отслеживания POLAR;
• F11 – включение/отключение режима отслеживания объектной привязки OTRACK;
• F12 – включение/отключение динамического ввода DYN;
• Esc или Ctrl+[, Ctrl+\ – прерывание текущей команды;
• Enter, Ctrl+M или Ctrl+J – повторное выполнение последней команды;
• Ctrl+A – выбор группы объектов;
• ALT+ F11 – вызов редактора Visual Basic;
• ALT+ F8 – вызов диалогового окна Macros;
• Ctrl+C – копирование объектов в буфер обмена Windows;
• Ctrl+H – включение/отключение системной переменной PICKSTYLE;
• Ctrl+I – включение/отключение системной переменной COORDS;
• Ctrl+N – создание нового чертежа, открытие диалогового окна Create New Drawing;
• Ctrl+O – открытие существующего файла чертежа и диалогового окна Select File;
• Ctrl+P – вывод текущего чертежа на печать, открытие диалогового окна Plot – Model;
• Ctrl+R – циклическое переключение между видовыми экранами листов;
• Ctrl+S – сохранение текущего рисунка;
• Ctrl+T – включение и отключение режима Планшет;
• Ctrl+V – вставка объектов из буфера обмена данных в текущий чертеж;
• Ctrl+X – удаление выбранных объектов из чертежа и копирование их в буфер обмена

данными;
• Ctrl+Y – восстановление только что отмененного действия;
• Ctrl+Z – отмена последней команды;
• Ctrl+ Shitf+A – включение/отключение групп;
• Ctrl+ Shitf+C – копирование объектов в буфер обмена с базовой точкой;
• Ctrl+ Shitf+S – вызов диалогового окна Save Drawing As;
• Ctrl+ Shitf+V – вставка данных из буфера обмена в виде одного блока;
• Ctrl+ Page Up – перемещение на следующую вкладку слева от текущей;
• Ctrl+ Page Down – перемещение на следующую вкладку справа от текущей;
• Ctrl+0 – включение/отключение режима чистого экрана;
• Ctrl+1 – включение/отключение палитры управления свойствами объектов;
• Ctrl+2 – включение/отключение Центра управления DesignCenter;
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• Ctrl+3 – открытие/закрытие окна инструментальных палитр;
• Ctrl+4 – включение/отключение диспетчера подшивок наборов листов;
• Ctrl+5 – включение/отключение информационной палитры INFO;
• Ctrl+6 – включение/отключение диспетчера подключения к базам данных, загрузка

палитры dbConnect Manager;
• Ctrl+7 – включение/отключение диспетчера наборов пометок;
• Ctrl+8 – включение/отключение палитры калькулятора;
• Ctrl+9 – включение/отключение окна команд.
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Контекстное меню

 
Для выбора пунктов меню и пиктограмм на панели инструментов часто используется

устройство указания – мышь. При работе с мышью щелчок левой кнопкой в области рисования
обычно используется для выбора и указания точки на экране; щелчок правой кнопкой мыши
вызывает контекстное меню, которое обеспечивает быстрый доступ к командам (см. рис. 2.4,
2.19). Форма и содержание меню зависят от положения указателя мыши и состояния задачи.

Рис. 2.19. Пример контекстного меню

При щелчке правой кнопкой мыши в области рисования вызывается одно из шести кон-
текстных меню:

• стандартное – вызывается при отсутствии выбранных объектов и активных команд.
Содержит последнюю используемую команду, набор стандартных функций, предназначенных,
в частности, для работы с буфером обмена, команды зумирования, панорамирования, а также
вызов диалогового окна настройки рабочей среды Options;

• команда – вызывается при выполнении какой-либо команды. Содержит набор ключей,
отображаемых в командной строке, облегчающих выполнение текущей команды с помощью
мыши;
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• объектная привязка – вызывается при щелчке правой кнопкой мыши и одновремен-
ном нажатии клавиши Shift. Позволяет выбрать или настроить режимы объектной привязки и
включить координатный фильтр;

• редактирование – вызывается при выбранном одном или нескольких объектах и отсут-
ствии активных команд. Объединяет функции, предназначенные для редактирования объек-
тов. Набор функций может изменяться в зависимости от типа выбранного объекта;

• ручки – вызывается при выделенной на объекте активной ручке. Содержит функции,
позволяющие проводить редактирование с помощью ручек;

• OLE – вызывается при щелчке правой кнопкой мыши на вставленном в рисунок OLE-
объекте. Объединяет функции, позволяющие редактировать OLE-объекты.

Контекстные меню объектная привязка, ручки и OLE всегда включены, а потому их
можно вызывать в любой момент. Контекстные же меню стандартное, редактирование и
команда можно отключить. В этом случае щелчок правой кнопкой мыши будет соответство-
вать нажатию клавиши Enter. По умолчанию вызов этих трех контекстных меню включен.

Для других элементов окна AutoCAD, кроме области рисования, можно вызывать сле-
дующие контекстные меню:

• панель инструментов – вызывается щелчком правой кнопки мыши на свободной обла-
сти правее стандартной панели инструментов или на одном из инструментов. Содержит список
панелей и предназначена для их включения/отключения или настройки;

• командная строка – вызывается щелчком правой кнопки мыши на командной строке
или в окне команд. Содержит список из шести команд, выполнявшихся последними, и служит
для вызова некоторых функций, используемых при работе с командной строкой;

• диалоговое окно – вызывается щелчком правой кнопки мыши на элементе диалогового
окна. Доступно не для всех диалоговых окон и, как правило, связано либо с раскрывающимися
списками, либо с полями для ввода значений и позволяет удалять, переименовывать отдельные
пункты списка или работать с буфером обмена;

• строка состояния – вызывается щелчком правой кнопки мыши на области строки
состояния, где выводятся текущие координаты, либо на любой кнопке переключения режимов
рисования или изменения настроек. Служит для переключения режимов рисования или изме-
нения их настроек;

• вкладки Model/Layout – вызывается щелчком правой кнопки мыши на вкладке Model
или одной из вкладок Layout. Используется для вызова окон печати и настройки параметров
страницы, а также управления листами.
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Инструментальные палитры

 

Инструментальные палитры загружаются командой TOOLPALETTES из падающего
меню Tools → Palettes → Tool Palettes (CTRL+3) либо щелчком на пиктограмме Tool Palettes
Window (Ctrl+3) на стандартной панели инструментов.

Инструментальные палитры представляют собой отдельные вкладки, объединенные в
специальном окне Tool Palettes (рис. 2.20), и являются эффективным средством хранения и
вставки блоков и штриховки, а также могут содержать инструменты, предоставленные сторон-
ними разработчиками.
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Рис. 2.20. Инструментальная палитра

В разных областях окна инструментальных палитр с помощью контекстных меню можно
изменять следующие настройки:

• автоматически убирать палитры с экрана – окно инструментальных палитр может авто-
матически разворачиваться и сворачиваться при подведении указателя мыши к строке заго-
ловка окна и отведении от нее;
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• прозрачность – окно палитры инструментов делается прозрачным и не скрывает нахо-
дящиеся за ним объекты (эта функция недоступна для пользователей Microsoft Windows NT);

• вид – изменяются стиль и размер отображаемых в палитре значков.
Окно инструментальных палитр при необходимости можно закрепить у правой или левой

границы окна программы. Для того чтобы избежать закрепления, при перемещении окна сле-
дует удерживать нажатой клавишу Ctrl.

На палитрах удобно размещать часто используемые блоки и штриховки. Для того чтобы
вставить блок или штриховку c палитры в рисунок, необходимо «захватить» элемент палитры
с помощью мыши и перетащить его в графическую область.

Блоки и штриховки, размещенные на палитре, носят название «инструменты». Некото-
рые свойства инструментов, включая масштаб, угол поворота и слой, могут устанавливаться
отдельно для каждого инструмента.

Блоки, вставляемые в рисунок с палитр, часто требуется масштабировать и поворачи-
вать. При перетаскивании блоков с палитры можно использовать объектную привязку, однако
шаговая привязка в это время не действует.

При перетаскивании блока с инструментальной палитры на рисунок он автоматически
масштабируется в зависимости от соотношения заданных единиц блока и единиц текущего
рисунка. Например, если в качестве единиц измерения данного рисунка используются метры,
а в качестве единиц измерения блока – сантиметры, то коэффициент пересчета составляет
1:100. Соответственно при перетаскивании блока в рисунок его размеры меняются в пропор-
ции 1:100.

Для добавления инструментов на палитру можно:
• перетаскивать рисунки, блоки и штриховки из Центра управления на инструменталь-

ную палитру. Если туда занесен целый рисунок, то при перетаскивании с палитры в графиче-
скую область он вставляется как блок;

• перетаскивать на палитру элементы чертежа;
• перемещать и копировать инструменты с одной палитры на другую при помощи команд

контекстного меню Cut – вырезать, Copy – копировать и Paste – вставить;
• перетаскивать на палитру команды из области Command List: диалогового окна

Customize User Interface.
Можно создать новую палитру. Чтобы она сразу оказалась заполнена инструментами,

необходимо щелкнуть правой кнопкой мыши на папке, файле рисунка или блоке в Центре
управления, а затем выбрать из контекстного меню пункт Create Tool Palette.

Порядок размещения инструментов на палитре изменяется в результате перетаскивания
их с помощью мыши.

Если в нижнем углу палитры высвечивается значок замка, это значит, что файлу инстру-
ментальной палитры присвоен атрибут только чтения Read only.

Настройки инструментальных палитр сохраняются в профиле AutoCAD. А экспортиру-
ются и импортируются палитры как файлы с расширением XTP.

Для изменения свойств инструментов, например масштаба блока и угла поворота образца
штриховки, необходимо щелкнуть правой кнопкой мыши на инструменте, а затем выбрать
из контекстного меню пункт свойств объекта Properties…. Далее в диалоговом окне свойств
инструмента Tool Properties изменяются свойства (рис. 2.21):

• название инструмента и пояснение к нему;
• параметры вставки или образца – угол поворота, масштаб;
• общие свойства – слой, цвет, тип линий и стиль печати.
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Рис. 2.21. Диалоговое окно свойств инструментов палитры
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Центр управления AutoCAD DesignCenter

 
В практической деятельности очень важно иметь возможность использовать создан-

ные ранее наработки: опыт показывает, что большинство проектно-конструкторских проектов
создается на базе новых сочетаний элементов, давно известных как по принципу функциони-
рования, так и по исполнению. AutoCAD обеспечивает эффективное повторное использова-
ние имеющихся наработок путем их вставки в рисунки в виде блоков или внешних ссылок.
Управлять блоками, внешними ссылками, растровыми изображениями и содержимым рисун-
ков, находящихся в других источниках (и даже подготовленных в других приложениях), поз-
воляет Центр управления AutoCAD DesignCenter.

Кроме того, если в сеансе открыто несколько рисунков, Центр управления дает возмож-
ность упростить процесс создания таких элементов, как, например, описания одних и тех же
слоев. Пользователь создает описание в одном рисунке, а затем просто копирует в остальные.

Центр управления DesignCenter предназначен для организации доступа к чертежам и их
элементам и обеспечивает:

• просмотр содержимого чертежей на локальном диске, сетевом диске и веб-страницах;
• просмотр и вставку в текущий чертеж блоков, слоев, текстовых и размерных стилей,

типов линий, внешних ссылок, образцов штриховки и прочих элементов чертежей;
• доступ к растровым изображениям и сторонним объектам, созданным в других прило-

жениях;
• обновление описания блоков;
• перетаскивание элементов чертежа на инструментальные палитры.
Центр управления AutoCAD загружается командой ADCENTER, либо из падающего

меню Tools → Palettes → DesignCenter (Ctrl+2), либо щелчком на пиктограмме DesignCenter
(Ctrl+2) на стандартной панели инструментов (рис. 2.22).

Рис. 2.22. Центр управления DesignCenter

Центр управления имеет интуитивно понятный интерфейс и позволяет быстро находить,
просматривать, вызывать и применять специфические компоненты, такие как блоки, слои,
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типы линий и пр. Причем эти операции осуществляются из открытых или закрытых файлов
AutoCAD независимо от того, где они находятся: на локальных или удаленных дисках. Доста-
точно просто выбрать нужные компоненты и перетащить их в текущий рисунок.

Панель инструментов, расположенная вверху Центра управления DesignCenter, обеспе-
чивает доступ к набору режимов и операций, а также осуществляет навигацию внутри окна
и просмотр информации в области структуры и содержимого. Область структуры находится
слева, в ней отображаются источники содержимого. Справа находится область содержимого,
предназначенная для добавления элементов в чертеж или на инструментальную палитру.
Область просмотра образца и пояснений к нему расположена справа внизу окна.

Центр управления включает следующие вкладки:
• Folders – вкладка, отображающая дерево иерархической структуры папок. Если слева, в

области структуры, с помощью мыши выбрать элемент, то справа отобразится его содержимое;
• Open Drawings – вкладка, отображающая список чертежей, открытых в текущий

момент. Для того чтобы справа, в области содержимого, отобразить элементы, необходимо
слева, в области структуры, выбрать файл чертежа, а затем из списка – одну из таблиц описа-
ний;

• History – вкладка, отображающая список последних файлов, открывавшихся с помо-
щью Центра управления. При двойном нажатии в списке на файле чертежа открывается папка
Folders с этим чертежом и его элементами в области содержимого;

• DC Online – интернет-модуль Центра управления, обеспечивающий доступ к содержи-
мому на веб-страницах, включая блоки, библиотеки компонентов, библиотеки разработчиков
и интернет-каталоги.

Для добавления элементов из области содержимого в текущий чертеж выбранный эле-
мент достаточно перетащить в графическую область чертежа либо воспользоваться одним из
вариантов, предлагаемых в контекстном меню. Также из области содержимого Центра управле-
ния можно перетащить чертежи, блоки и штриховки на текущую инструментальную палитру.
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Просмотр и поиск содержимого

 
Для просмотра элементов содержимого, находящихся в текущем источнике, служит зона

содержимого, или палитра, – средство AutoCAD, предназначенное для просмотра содержи-
мого открытых рисунков и других источников, а также образцов и описаний перед вставкой
идентифицируемых ими объектов в рисунок. Кроме этого, палитра может использоваться для
поиска на диске файлов рисунков по их содержимому.

Просматривать открытые рисунки, журнал предыдущих рисунков, а также файлы и
папки локального и сетевых дисков можно в зоне структуры, которая является хорошим
помощником при перемещении по содержимому рисунка, но ее присутствие на экране необя-
зательно для загрузки палитры.

На палитре отображаются крупные значки, а в зоне структуры показана структура рабо-
чего стола. Перемещаясь по структуре, можно выбирать источники и загружать их содержимое
в палитру.

Ниже приводятся способы размещения Центра управления AutoCAD на рабочем столе:
• для изменения размеров окна следует захватить с помощью мыши его границу, разде-

литель зон или ручку в правом нижнем углу и перетащить ее в нужное положение;
• для освобождения окна нужно щелкнуть на его заголовке, перетащить окно за пределы

зоны закрепления и отпустить кнопку мыши. Окно станет плавающим, и его можно будет пере-
мещать в любое место экрана;

• для закрепления окна нужно либо перетащить его в одну из зон закрепления (в левой
или правой части окна AutoCAD), либо дважды щелкнуть кнопкой мыши по заголовку плава-
ющего окна. При перетаскивании окна никакие особые действия по закреплению не нужны –
оно закрепляется само, достигнув крайней части области рисования.

В дополнение к поиску рисунков с нужными элементами вручную путем перемещения по
структуре Центр управления AutoCAD обеспечивает автоматический поиск рисунков, описа-
ний блоков и слоев, а также элементов сторонних приложений по именам. Для этого исполь-
зуется инструмент Search, при щелчке на котором открывается диалоговое окно Search – рис.
2.23.
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Рис. 2.23. Диалоговое окно поиска

Здесь можно настроить поиск по различным критериям, в том числе по дате послед-
него изменения. Допускается также поиск по фрагментам текста, содержащимся в текстовых
описаниях блоков или в полях свойств рисунка. Например, если имя рисунка неизвестно, его
можно найти по ключевому слову, заданному в свойствах. Если же пользователь желает отыс-
кать созданный им блок, но не помнит точно, как он был сохранен (в рисунке или в отдельном
файле), следует задать в качестве критерия имя блока, а из списка Look for выбрать Drawings
and Blocks. Выбранный тип определяет вид вкладок диалогового окна. Далее необходимо вве-
сти в поле In начальный участок поиска или нажать кнопку Browse… и выбрать его в струк-
туре диска. Если поиск должен охватывать все уровни, подчиненные указанному, требуется
установить флажок для просматривания вложенных папок Search subfolders.

Если в списке Look for выбран пункт Drawings, то в диалоговом окне Search появляются
три вкладки, на которых можно задать различные критерии поиска:

• Drawings – имя или текст для поиска, возможно, вместе с именем свойства. Разрешается
задавать искомый текст и указывать, к чему он относится (к названию файла, имени автора
и т. д.);

• Date Modified – дата или диапазон дат создания или последнего изменения искомого
элемента содержимого. Может также задаваться в формате during the previous N month(s) – за
последние N месяцев или during the previous N day(s) – за последние N дней. По умолчанию
AutoCAD не ограничивает поиск по дате;

• Advanced – дополнительные параметры поиска. Здесь можно, например, настроить
поиск рисунков, содержащих некоторую текстовую строку (в именах блоков, именах или значе-
ниях атрибутов, а также в текстовых описаниях элементов). Кроме того, предусмотрено огра-
ничение поиска по минимальному или максимальному размеру файла. При поиске допускается
ввод как всей текстовой строки, так и отдельного ее фрагмента. Можно также использовать
глобальные символы (* и ?).
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Если в списке Look for выбрано значение, отличное от Drawings, то в диалоговом окне
Search появляется одна из нижеперечисленных вкладок:

• Blocks – поиск блоков по именам;
• Dimstyles – поиск размерных стилей по именам;
• Drawings and Blocks – поиск рисунков и блоков по именам;
• Hatch Pattern Files – поиск файлов образцов штриховки по именам;
• Hatch Patterns – поиск образцов штриховки по именам;
• Layers – поиск слоев по именам;
• Layouts – поиск листов по именам;
• Linetypes – поиск типов линий по именам;
• Tablestyles – поиск табличных стилей по именам;
• Textstyles – поиск текстовых стилей по именам;
• Xrefs – поиск внешних ссылок по именам.
Для запуска механизма поиска следует нажать кнопку Search Now. Записи о найденных

элементах отображаются в диалоговом окне по мере их обнаружения. Для нового поиска с
другими критериями нужно воспользоваться кнопкой New Search. После щелчка на ней список
с результатами предыдущего поиска будет очищен.

Элемент содержимого, найденный во время поиска и занесенный в таблицу результа-
тов, можно добавить в открытый рисунок. Результат поиска также можно загрузить непосред-
ственно на палитру Центра управления.

Для смены источника содержимого зоны структуры необходимо в Центре управления
AutoCAD открыть одну из следующих вкладок или выбрать их из контекстного меню, щелкнув
правой кнопкой мыши на свободной части палитры:

• Folders – перечень локальных и сетевых дисков;
• Open Drawings – перечень рисунков, открытых в данный момент в AutoCAD;
• History – перечень последних 20 элементов, открытых через Центр управления

AutoCAD;
• DC Online – подключение к Интернету.
Центр управления AutoCAD предоставляет очень простой способ открытия файлов

рисунков – пользователю достаточно всего лишь перетащить значок выбранного файла в
пустую часть области рисования. При этом следует быть внимательным, так как перетаскива-
ние значка не в пустую часть, а в открытый рисунок приведет к другому результату.

Для перетаскивания необходимо, чтобы хотя бы часть области рисования не была
покрыта рисунками. Этого можно достичь, уменьшив размеры открытых окон или свернув
их. Если при перетаскивании вывести указатель мыши за пределы окна AutoCAD, он примет
форму перечеркнутого круга – значит, оставлять рисунок в этом месте нельзя.

Таким образом, с помощью Центра управления AutoCAD можно:
• просматривать различные источники содержимого рисунков, начиная с документов,

открытых в текущем сеансе AutoCAD, и вплоть до библиотек обозначений на веб-страницах;
• просматривать описания блоков, слоев и других элементов в любом файле рисунка,

вставлять и копировать эти описания в текущий рисунок;
• создавать ярлыки для часто используемых рисунков, папок и интернет-страниц;
• находить рисунки с нужным содержимым на локальном и сетевых дисках. Так, напри-

мер, можно разыскать рисунок, в котором имеется слой с заданным именем, либо файл, сохра-
ненный до или после указанной даты. Найденный рисунок можно загрузить в Центр управле-
ния или перетащить непосредственно в текущий документ;

• открывать рисунки путем перетаскивания DWG-файлов с палитры в область рисова-
ния;
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• просматривать и вставлять растровые изображения путем перетаскивания их файлов
с палитры в область рисования;

• управлять представлением элементов палитры (крупные или мелкие значки, список
или таблица). Также предусмотрено отображение на палитре образцов и текстовых описаний
элементов рисунка.
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Глава 3

Настройка рабочей среды AutoCAD
 

Определение доступа к файлам поддержки
Настройка параметров рабочего экрана
Настройка параметров открытия и сохранения файлов
Определение параметров вывода на печать
Настройка системных параметров
Настройка пользовательской среды
Управление точностью построения объектов
Настройка параметров трехмерного моделирования
Настройка параметров выбора объектов
Настройка профилей

Пользователь имеет возможность изменять различные параметры рабочей среды
AutoCAD, влияющие на конфигурацию интерфейса и условия рисования. Такие настройки
называются профилем. Пользователи, входящие в систему под одним именем, могут загружать
свои настройки из различных профилей. Целесообразно использование профилей для сохра-
нения настроек, присущих разным проектам.

Процедура настройки рабочей среды AutoCAD осуществляется в диалоговом окне
Options, которое вызывается из падающего меню Tools → Options… или из стандартного кон-
текстного меню при условии, что нет выполняющихся команд или выбранных объектов. Диа-
логовое окно Options содержит 10 вкладок, описанных ниже.
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Определение доступа к файлам поддержки

 
На вкладке Files диалогового окна Options, показанной на рис. 3.1, задаются пути доступа

к файлам поддержки, где хранятся шрифты, шаблоны рисунков, типы линий и образцы штри-
ховок, используемые AutoCAD. Здесь перечисляются все пути доступа к папкам, которые
должны существовать в текущей структуре папок локального и подключенных сетевых дисков.

Рис. 3.1. Диалоговое окно определения доступа к файлам поддержки

• В области Search paths, file names, and file locations: содержатся тематические заголовки
путей доступа к файлам и папкам поддержки:

• Support File Search Path – путь доступа к вспомогательным файлам;
• Working Support File Search Path – путь поиска рабочих вспомогательных файлов;
• Device Driver File Search Path – путь доступа к драйверам устройств;
• Project Files Search Path – путь доступа к файлам проектов;
• Customization Files – файлы настройки;
• Help and Miscellaneous File Names – имена файлов справочной системы и др.;
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• Text Editor, Dictionary, and Font File Names – имена файлов текстового редактора, сло-
варя и шрифтов;

• Print File, Spooler, and Prolog Section Names – имена файла печати, программы фоновой
печати и раздела пролога;

• Printer Support File Path – путь к вспомогательным файлам печати;
• Automatic Save File Location – папка для файла автосохранения;
• Color Book Locations – папки для альбомов цветов;
• Data Sources Location – положение источников данных;
• Template Settings – параметры шаблонов;
• Tool Palettes File Locations – папки с файлами инструментальных палитр;
• Authoring Palette File Locations – папки файлов палитры вариаций;
• Log File Location – расположение файла журнала;
• Plot and Publish Log File Location – папка для файла журнала печати/публикации;
• Temporary Drawing File Location – папка для временных файлов;
• Temporary External Reference File Location – папка для временных файлов внешних

ссылок;
• Texture Maps Search Path – папка для поиска текстур;
• Web File Search Path – папка для поиска веб-файлов;
• i-drop Associated File Location – папка для связанных файлов точек загрузки.
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Настройка параметров рабочего экрана

 
На вкладке Display диалогового окна Options, показанной на рис. 3.2, можно осуществ-

лять настройку параметров рабочего экрана AutoCAD.

Рис. 3.2. Диалоговое окно настройки параметров рабочего экрана

• В области элементов окна Window Elements настраиваются следующие параметры:
– Color Scheme: – установка тона фоновой области инструментов;
– Display scroll bars in drawing window – включаются/отключаются полосы прокрутки;
– Display Drawing status bar – включаются/отключаются инструменты строки состояния;
– Display screen menu – включается/отключается экранное меню;
– Use large buttons for Toolbars – изменяется размер пиктограмм инструментов с 16 × 15

на 24 × 22 пиксела;
– Show ToolTips – включаются/отключаются всплывающие подсказки около пиктограмм

инструментов;
– Show shortcut keys in ToolTips – включаются/отключаются комбинации клавиш в под-

сказках;
– кнопка Colors… – загружается диалоговое окно Drawing Window Colors, для изменения

цвета элементов рабочего стола AutoCAD (рис. 3.3):
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Рис. 3.3. Диалоговое окно изменения цвета элементов рабочего стола AutoCAD

· список Context: – выбор объекта, в контексте которого будет изменен цвет элемента:
2D model space – пространство двумерной модели, Sheet/layout – лист, 3D parallel projection
– трехмерная параллельная проекция, 3D perspective projection – трехмерная перспективная
проекция, Block editor – редактор блоков, Command line – командная строка, Plot preview –
просмотр печати;

· список Interface element: – выбор элемента интерфейса, цвет которого необходимо уста-
новить. Для пространства двумерной модели и листа – однородный фон, перекрестье, век-
тор автоотслеживания, маркер автопривязки, подсказка при прочерчивании, фон подсказки,
источники света, яркое пятно, спад освещенности, начальный предел, конечный предел, цвет
обозначений камер, усеченная камера/плоскость усечения, плоскости подрезки камер. Для
трехмерной параллельной проекции – однородный фон, перекрестье, основные линии сетки,
промежуточные линии сетки, осевые линии сетки и далее, аналогично пространству двумерной
модели. Для трехмерной перспективной проекции – верх небесного фона, фоновый небесный
горизонт, фоновое наземное начало, фоновый наземный горизонт, низ земного фона, фоно-
вый земной горизонт и далее, аналогично трехмерной параллельной проекции. Для редактора
блоков – однородный фон, перекрестье, вектор автоотслеживания, маркер автопривязки, под-
сказка при прочерчивании, фон подсказки, источники света, яркое пятно, спад освещенности,
начальный предел, конечный предел. Для командной строки – однородный фон и текст. Для
просмотра печати – однородный фон;
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· список Color: – выбор оттенка из цветовой палитры;
· кнопка Restore current element – восстановление текущего элемента;
· кнопка Restore current context – восстановление текущего контекста;
· кнопка Restore all contexts – восстановление всех контекстов;
· в области Preview: показан образец с текущими установками цвета;
– кнопка Fonts… – загружается диалоговое окно Command Line Window Font, для изме-

нения шрифта текста командной строки (рис. 3.4). В этом диалоговом окне устанавливаются:
Font: – шрифт, Font Style: – начертание и Size: – размер. В области Sample Command Line Font
показывается образец шрифта командной строки.

Рис. 3.4. Диалоговое окно изменения шрифтов

• В области Layout elements назначаются следующие параметры пространства листа:
– Display Layout and Model tabs – управляет отображением вкладок Layout и Model;
– Display printable area – управляет отображением границ печатаемой области;
– Display paper background – управляет отображением фона;
– Display paper shadow – управляет отображением тени вокруг границ;
– Show Page Setup Manager for new layouts – управляет выводом Диспетчера параметров

для новых листов;
– Create viewport in new layouts – назначает создание видовых экранов на новых листах.
• В области экранного разрешения Display resolution определяются:
– Arc and circle smoothness – плавность отображения дуг и окружностей;
– Segments in a polyline curve – количество сегментов в дугах полилиний;
– Rendered object smoothness – плавность отображения тонированных объектов;
– Contour lines per surface – количество образующих в поверхностях.
• В области Display performance настраивается производительность отображения объек-

тов:
– Pan and zoom with raster & OLE – управляет динамическим отображением в реальном

времени растровых изображений. Текущее значение параметра хранится в системной пере-
менной RTDISPLAY;

– Highlight raster image frame only – управляет подсветкой растровых изображений при
их выборе. При установке флажка подсвечиваются только границы растра. Текущее значение
параметра хранится в системной переменной IMAGEHLT;
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– Apply solid fill – управляет закраской плоских фигур и полилиний ненулевой ширины.
При установке флажка показывается закраска. Текущее значение параметра хранится в систем-
ной переменной FILLMODE;

– Show text boundary frame only – управляет отображением текста на экране. При уста-
новке флажка отображаются только границы текстов. Текущее значение параметра хранится в
системной переменной QTEXTMODE;

– Draw true silhouettes for solids and surfaces – настраивает отображение контура трех-
мерного объекта. При установке флажка вычерчиваются кромки силуэтов тел и поверхностей.
Текущее значение параметра хранится в системной переменной DISPSILH.

• В области Crosshair size устанавливается размер перекрестья в процентах от размера
экрана.

• В области Reference Edit fading intensity устанавливается затенение при редактировании
ссылок.
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Настройка параметров открытия и сохранения файлов

 
Вкладка открытия и сохранения файлов Open and Save диалогового окна Options пока-

зана на рис. 3.5.

Рис. 3.5. Диалоговое окно настройки параметров открытия и сохранения файлов

На ней осуществляется настройка следующих параметров.
• В области File Save – параметры сохранения файлов:
– в списке Save As: устанавливается сохранение файлов в заданном формате;
– кнопка Thumbnail Preview Setings… загружает одноименное диалоговое окно (рис.

3.6), осуществляющее настройку образцов для просмотра. Флажком Save a thumbnail preview
image назначается создание образца для просмотра. Флажком Generate Sheet, Sheet View and
Model View Thumbnails – создание образцов листов и видов листа/модели. Расположенная
ниже линейка регулирует Perfomance – производительность и Accuracy – точность;
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Рис. 3.6. Диалоговое окно настройки образцов для просмотра

– в поле Incremental save percentage определяется процент для быстрых сохранений.
• В области File Safety Precautions определяются меры предосторожности при сохране-

нии:
– Automatic save – включение функции автоматического сохранения файла;
– Minutes between saves – определение интервала между сохранениями в минутах;
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– Create backup copy with each save – обеспечение создания резервных копий;
– Full-time CRC validation – осуществление постоянной проверки контрольной суммы;
– Maintain a log file – ведение файла журнала;
– File extension for temporary files – определение расширения для временных файлов;
– кнопка Security Options… – загрузка одноименного диалогового окна, предназначен-

ного для определения параметров безопасности, в котором можно задать пароль для открытия
текущего чертежа или цифровую подпись;

– Display digital signature information – отображение информации о цифровой подписи.
• В области File Open определяется: Number of recently-used files – количество последних

файлов, указываемых в падающем меню, и Display full path in title – назначаются полные пути
в заголовках.

• В области External References (Xrefs) определяются следующие параметры внешних
ссылок:

– в списке Demand load Xrefs: – управление подгрузкой файлов внешних ссылок. Выби-
рается одно из значений: Disabled – запрещено, Enabled – разрешено или Enabled with copy –
разрешено с копированием;

– Retain changes to Xref layers – сохранение изменений слоев ссылок;
– Allow other users to Refedit current drawing – разрешение редактирования рисунка как

ссылки.
• В области ObjectARX Applications определяются следующие параметры приложений:
– в списке подгрузки приложений Demand load ObjectARX apps: устанавливается один

из режимов: Disable load on demand – отключение загрузки по запросу, Custom object detect
– обнаружение сторонних объектов, Command invoke – вызов команды или Object detect and
command invoke – обнаружение объектов и вызов команды;

– в списке заместителей для сторонних объектов Proxy images for custom objects: назна-
чается один из режимов: Do not show proxy graphics – не показывать элементы, Show proxy
graphics – показывать элементы или Show proxy bounding box – показывать только рамку;

– Show Proxy Information dialog box: – назначается вывод окна сведений о заместителях.
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Определение параметров вывода на печать

 
Параметры печати задаются на вкладке Plot and Publish диалогового окна Options – рис.

3.7.

Рис. 3.7. Диалоговое окно определения параметров вывода на печать

• В области Default plot settings for new drawings настраиваются параметры печати для
новых чертежей по умолчанию:

– Use as default output device – устройство вывода по умолчанию;
– Use last successful plot settings – последнее успешно использованное устройство;
– кнопка Add or Configure Plotters… – добавление и настройка плоттеров.
• В области Plot to file настраивается печать в файл, то есть определяется расположение

файлов чертежей по умолчанию и задается папка, в которую должны записываться файлы чер-
тежей при печати в файл.

• В области Background processing options настраиваются параметры фоновой обработки
установкой режима поддержки фонового вывода: Plotting – печать, Publishing – публикация.

• В области Plot and publish log file назначается ведение журнала:
– Automatically save plot and publish – вести журнал автоматически;
– Save one continuous plot log – общий файл для всех операций;
– Save one log per plot – отдельный файл для каждой операции.
• В области Auto publish назначается автопубликация:
– Automatic DWF Publish – автоматическая публикация DWF-формата;



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

85

– кнопка Automatic DWF Publish Settings… – загрузка диалогового окна Auto Publish
Options.

• В области общих параметров печати General plot options определяются следующие пара-
метры:

– Keep the layout paper size if possible – сохранение (если возможно) размеров листа при
смене устройства печати;

– Use the plot device paper size – использование размеров листа из устройства при смене
устройства печати;

– в списке System printer spool alert: устанавливается режим предупреждения о буфери-
зации:

· Always alert (and log errors) – всегда (регистрировать все ошибки);
· Alert first time only (and log errors) – в первый раз (регистрировать все ошибки);
· Never alert (and log first error) – никогда (регистрировать первую ошибку);
· Never alert (do not log errors) – никогда (не регистрировать ошибки);
– в списке OLE plot quality: устанавливается качество печати OLE-объектов:
· Monochrome (e.g. spreadsheet) – монохромное (например, таблица);
· Low graphics (e.g. color text !& pie charts) – простая графика (например, круговая диа-

грамма);
· High graphics (e.g. photograph) – сложная графика (например, фотография);
· Automatically select – автоматический выбор;
– Use OLE application when plotting OLE objects – назначение печати OLE-объектов в

OLE-приложениях;
– Hide system printers – запрещение показа системных принтеров.
• В области Specify plot offset relative to определяется отсчет смещения чертежа:
– Printable area – от области печати;
– Edge of paper – от края листа.
• Кнопка Plot Stamp Settings… загружает диалоговое окно Plot Stamp, позволяющее

настроить параметры штемпелей чертежей (рис. 3.8):
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Рис. 3.8. Диалоговое окно штемпеля чертежа

– в области Plot stamp fields определяется информация для штемпеля:
· Drawing name – имя чертежа;
· Layout name – имя вкладки;
· Date and Time – дата и время;
· Login name – пользователь;
· Device name – устройство;
· Paper size – формат листа;
· Plot scale – масштаб чертежа;
– в области Preview демонстрируется образец штемпеля;
– в области User defined fields определяется дополнительная информация. Кнопка Add/

Edit загружает диалоговое окно User Defined Fields, позволяющее внести добавления и изме-
нения;

– в области Plot stamp parameter file назначается файл параметров штемпеля. Кнопки
Load и Save As позволяют загрузить и сохранить файлы;

– кнопка Advanced загружает диалоговое окно Advanced Options (рис. 3.9), позволяющее
определить дополнительные параметры:
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Рис. 3.9. Диалоговое окно дополнительных параметров

· в области Location and offset задаются расположения и отступы: Location: – расположе-
ние (внизу слева, вверху слева, вверху справа или внизу справа); Orientation: – ориентация (вер-
тикально или горизонтально); Stamp upside-down – перевернутый штемпель; X offset – отступ
по оси X; Y offset – отступ по оси Y; Offset relative to printable area – отступ относительно обла-
сти печати; Offset relative to paper border – отступ относительно границ листа;

· в области Text properties назначаются свойства текста. Font: – шрифт; Height: – высота;
Single line plot stamp – однострочный штемпель;

· в области Plot stamp units определяются единицы для штемпеля (дюймы, миллиметры
или пикселы);

· в области Log file Location определяется расположение файла журнала. Create a log file
– вести журнал в файле; кнопка Browse… загружает диалоговое окно обзора.

• Кнопка Plot Style Table Settings… загружает одноименное диалоговое окно, позволяю-
щее настроить таблицы стилей печати (рис. 3.10):
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Рис. 3.10. Диалоговое окно параметров таблиц стилей печати

– в области Default plot style behavior for new drawing определяются стили печати по умол-
чанию для новых чертежей:

· Use color dependent plot styles – цветозависимые стили печати;
· Use named plot styles – именованные стили печати;
– в области Current plot style table settings настраивается текущая таблица стилей печати:
· в списке Default plot style table – таблица стилей печати по умолчанию;
· в списке Default plot style for layer 0: – стиль печати по умолчанию для слоя 0;
· в списке Default plot style for objects: – стиль печати по умолчанию для объектов;
– кнопка Add or Edit Plot Style Tables… загружает таблицы стилей печати.
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Настройка системных параметров

 
Для настройки системных параметров AutoCAD используется вкладка System диалого-

вого окна Options – рис. 3.11.

Рис. 3.11. Диалоговое окно настройки системных параметров

• В области 3D Perfomance определяется производительность трехмерной графики.
Кнопка Perfomance Settings загружает диалоговое окно Adaptive Degradation and Peromance
Tuning (рис. 3.12), позволяющее оптимизировать параметры:
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Рис. 3.12. Диалоговое окно адаптивного ухудшения и оптимизации параметров

– в области Adaptive degradation настраивается адаптивное ухудшение трехмерной гра-
фики:

· Degrade when FPS is below: – ухудшать, если показатель «кадры в секунду» меньше, чем
указанное значение в поле;

· Degradation order: – настраивается порядок ухудшения. Необходимо удалить отметку
для элементов, которые не следует ухудшать (объекты, зависящие от вида; сглаживание линий;
освещение; качество прозрачности; полные тени; прозрачность; не учитывать задние грани;
тени на земле; стили ребер; ребра граней; быстрые силуэты; текстуры; материалы; качество
освещения; фон; ребра пересечения; отображение граней; отображение каркаса). Рекоменду-
ется удалять незначительное количество;

· Learn about adaptive degradation – ссылка на информацию об адаптивном ухудшении;
– в области Hardware and performance tuning оптимизируются параметры оборудования и

программного обеспечения трехмерной графики. Управление текущей конфигурацией аппа-
ратного обеспечения выполняется Мастером оптимизации параметров;

· кнопка View Tune Log обеспечивает просмотр протокола оптимизации;
· кнопка Manual Tune загружает диалоговое окно Manual Perfomance Tuning (рис. 3.13),

которое обеспечивает ручную оптимизацию параметров: Enable hardware acceleration – вклю-
чает аппаратное ускорение; в списке Driver name: – указывается имя драйвера; ниже вклю-
чаются и отключаются эффекты (ускорение для геометрии, отображение сглаженных линий,
модуль раскрашивания по Гучу, полное отображение теней). Далее указываются общие пара-
метры: Discard back faces – не учитывать задние грани; Transparency quality: – качество
прозрачности (высокое, среднее, низкое). В нижней части диалогового окна регулируется
Dynamic tessellation – динамическая аппроксимация: Surfaces: – при визуализации поверхно-
стей, Curves: – при визуализации кривых; в списке Number of tessellations to cache: указывается
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количество уровне аппроксимации. Кнопка Reset to Recommended Values дает возможность
вернуться к рекомендованным значениям;
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Рис. 3.13. Диалоговое окно ручной оптимизации параметров

· кнопка Check for Updates осуществляет проверку обновлений.
• В области Current Pointing Device выбирается текущее устройство указания, а также

источник входных данных: Digitizer only – только дигитайзер, Digitizer and mouse – дигитайзер
и мышь.

• В области Layout Regen Options настраивается регенерация вкладок:
– Regen when switching layouts – регенерация при переключении;
– Cache model tab and last layout – кэширование модели и последнего листа;
– Cache model tab and all layouts – кэширование модели и всех листов.
• В области dbConnect Options устанавливаются параметры подключения к базам данных:
– Store Links index in drawing file – хранить индекс связей в рисунке;
– Open tables in read-only mode – открывать таблицы только для чтения.
• В области General Options назначаются общие параметры:
– Display OLE Text Size Dialog – вывод диалогового окна размера текста OLE-объектов;
– Beep on error in user input – оповещение об ошибках пользовательского ввода при

помощи звукового сигнала;
– Load acad.lsp with every drawing – загрузка файла acad.lsp с каждым рисунком;
– Allow long symbol names – разрешение на использование длинных имен.
• В области Live Enabler Options настраиваются параметры адаптеров объектов:
– Check Wed for Live Enablers – организуется поиск адаптеров в Интернете;
– Maximum number of unsuccessful checks – определяется максимальное число отрица-

тельных проверок.
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Настройка пользовательской среды

 
На вкладке User Preferences диалогового окна Options можно настроить пользователь-

скую среду рисования по своему усмотрению (рис. 3.14).

Рис. 3.14. Диалоговое окно настройки пользовательской среды

• В области Windows Standard Behavior назначается соответствие стандартам Windows:
– Double click editing – редактирование по двойному нажатию;
– Shortcut menus in drawing area – отображение контекстных меню в области рисования;
– кнопка Right-click Customizations… – загрузка одноименного диалогового окна, позво-

ляющего выбрать действия, к которым приводит щелчок правой кнопки мыши (рис. 3.15):
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Рис. 3.15. Диалоговое окно настройки правой кнопки мыши

· Turn on time-sensitive right-click – учитывать длительность нажатия: Quick click for
ENTER – кратковременное нажатие вызывает ENTER; Longer click to display Shortcut Menu –
долгое нажатие вызывает контекстное меню; Longer click duration: – продолжительность нажа-
тия;

· в области Default Mode настраивается обычный режим. Если нет выбранных объектов,
то правая кнопка вызывает: Repeat Last Command – повтор последней команды, Shortcut Menu
– контекстное меню;

· в области Edit Mode настраивается режим редактирования. Если объекты выбраны, то
правая кнопка вызывает: Repeat Last Command – повтор последней команды, Shortcut Menu
– контекстное меню;

· в области Command Mode настраивается командный режим. Если выполняется команда,
то правая кнопка вызывает: ENTER, Shortcut Menu: always enabled – всегда доступное кон-
текстное меню, Shortcut Menu: enabled when command options are present – контекстное меню,
доступное, если команда имеет ключи.

• В области Insertion scale определяется масштаб вставки. Если не заданы единицы
вставки, то использовать:
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– Source content units: – единицы исходного чертежа (дюймы, футы, мили, миллиметры,
сантиметры, метры, километры, микродюймы, милы, ярды, ангстремы, нанометры, микроны,
дециметры, декаметры, гектометры, гигаметры, астрономические единицы, световые годы,
парсеки);

– Target drawing units: – единицы целевого чертежа (дюймы, футы, мили, миллиметры,
сантиметры, метры, километры, микродюймы, милы, ярды, ангстремы, нанометры, микроны,
дециметры, декаметры, гектометры, гигаметры, астрономические единицы, световые годы,
парсеки).

• В области Fields определяются поля:
– флажок Display background of fields назначает отображение заднего плана;
– кнопка Field Update Settings… загружает одноименное диалоговое окно, позволяющее

настроить условия автоматического обновления полей (рис. 3.16):

Рис. 3.16. Диалоговое окно настройки обновления полей

· Open – открытие;
· Save – сохранение;
· Plot – печать;
· eTransmit – формирование комплекта;
· Regen – регенерация.
• В области Priority for Coordinate Data Entry определяются способы ввода координат:
– Running object snap – согласно привязке;
– Keyboard entry – с клавиатуры;
– Keyboard entry except scripts – с клавиатуры (кроме пакетов).
• В области Associative Dimensioning назначается ассоциативность новых размеров.
• В области гиперссылок Hyperlink назначаются курсор, подсказки и контекстное меню.
• В области Undo/Redo определяется, объединять ли команды зумирования и панорами-

рования.
• Кнопка Lineweight Settings… загружает одноименное диалоговое окно, позволяющие

определить параметры весов линий (рис. 3.17):
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Рис. 3.17. Диалоговое окно настройки параметров весов линий

– Lineweights – веса линий;
– Units for Listing – единицы в списке: Millimeters (mm) – миллиметры, Inches (in) –

дюймы;
– Display Lineweight – отображать линии в соответствии с весами. В раскрывающемся

списке Default – указывается значение веса линии по умолчанию;
– Adjust Display Scale – масштаб экранного отображения.
• Кнопка Edit Scale List… загружает одноименное диалоговое окно, позволяющее изме-

нить список масштабов (рис. 3.18).
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Рис. 3.18. Диалоговое окно изменения списка масштабов
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Управление точностью построения объектов

 
На вкладке построений Drafting диалогового окна Options, показанной на рис. 3.19,

можно сделать следующие назначения.

Рис. 3.19. Диалоговое окно управления точностью построения объектов

• В области AutoSnap Settings назначаются следующие параметры автопривязки:
– Marker – маркер;
– Magnet – магнит;
– Display AutoSnap tooltip – всплывающие подсказки автопривязки;
– Display AutoSnap aperture box – прицел автопривязки;
– кнопка Colors… загружает диалоговое окно Drawing Window Colors (см. рис. 3.3), поз-

воляющее изменить цвет маркера автопривязки.
• В области AutoSnap Marker Size определяется размер маркера автопривязки.
• В области Object Snap Options определяются параметры объектной привязки:
– Ignore hatch objects – игнорировать штриховку;
– Replace Z value with current elevation – заменить кординату Z на текущее значение

оценки;
– Ignore negative Z object snaps for Dynamic UCS – игнорировать для динамической ПСК

объектные привязки с отрицательной координатой Z.
• В области AutoTrack Settings назначаются следующие параметры автоотслеживания:
– Display polar tracking vector – бесконечные линии полярного отслеживания;
– Display full-screen tracking vector – бесконечные линии объектного отслеживания;
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– Display AutoTrack tooltip – всплывающие подсказки автоотслеживания.
• В области Alignment Point Acquisition задаются режимы захвата точек отслеживания:
– Automatic – автоматический;
– Shift to acquire – с нажатием клавиши Shift.
• В области Aperture Size определяется размер прицела.
• Кнопка Drafting Tooltip Settings… загружает диалоговое окно Tooltip Appearance (рис.

3.20), определяющее внешний вид подсказок:

Рис. 3.20. Диалоговое окно настройки внешнего вида подсказок

– Model Preview – предварительный просмотр внешнего вида подсказок в пространстве
модели;

– Layout Preview – предварительный просмотр внешнего вида подсказок в пространстве
листа;

– кнопка Colors… – загружает диалоговое окно Drawing Window Colors (см. рис. 3.3),
позволяющее изменить цвет подсказок;

– Size – изменение размера подсказок;
– Transparency – изменение прозрачности подсказок;
– Override OS settings for all drafting tooltips – замена параметров ОС для всех подсказок

на чертеже;



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

101

– Use settings only for Dynamic Input tooltips – замена параметров только для подсказок
динамического ввода.

• Кнопка Lights Glyph Settings… загружает диалоговое окно Light Glyph Appearance (рис.
3.21), определяющее вид обозначений источников света:

Рис. 3.21. Диалоговое окно настройки обозначений источников света

– Glyph Preview – предварительный просмотр образцов обозначений источников света:
Point – точечный источник, Spot – прожектор;

– кнопка Edit Glyph Colors загружает диалоговое окно Drawing Window Colors (см. рис.
3.3), позволяющее редактировать цветовую гамму обозначений источников света;

– Glyph Size: – установка размера обозначений источников света.
• Кнопка Cameras Glyph Settings… загружает диалоговое окно Camera Glyph Appearance

(рис. 3.22), определяющее вид обозначения камеры:
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Рис. 3.22. Диалоговое окно настройки обозначений камер

– кнопка Edit Glyph Colors… загружает диалоговое окно Drawing Window Colors (см. рис.
3.3), позволяющее редактировать цветовую гамму обозначения камеры;

– Glyph Size: – установка размера обозначений камеры.
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Настройка параметров трехмерного моделирования

 
Вкладка настройки параметров трехмерного моделирования 3D Modeling диалогового

окна Options, показанная на рис. 3.23, позволяет сделать следующие назначения.

Рис. 3.23. Диалоговое окно настройки параметров трехмерного моделирования

• В области 3D Crosshairs определяются параметры трехмерного перекрестья:
– Show Z axis in crosshairs – показывать ось Z в перекрестьях;
– Label axes in standard crosshairs – метки осей в стандартных перекрестьях;
– Show labels for dynamic UCS – показывать метки динамической ПСК;
– Crosshair labels – установка параметров меток на перекрестьях: Use X, Y, Z – исполь-

зовать X, Y, Z; Use N, E, z – использовать N, E, z; Use custom labels – использовать пользова-
тельские метки.

• В области Display ViewCube or UCS Icon определяются параметры показа значка ПСК:
– Display UCS Icon in 2D model space – показывать значок ПСК в двумерном пространстве

модели;
– Display in 3D model space – показывать значок ПСК в трехмерном пространстве модели.
• В области Display Input определяется параметр динамического ввода:
– Show Z field for pointer input – показывать поле для ввода Z.
• В области 3D Objects определяются параметры трехмерных объектов:
– в списке Visual Style while creating 3D objects устанавливается визуальный стиль при

создании трехмерных объектов: ByViewport – по видовому экрану, 2D Wireframe – двумерный
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каркас, 3D Hidden – трехмерный скрытый, 3D Wireframe – трехмерный каркас, Conceptual –
концептуальный, Realistic – реалистичный;

– в списке Deletion control while creating 3D objects определяется управление удалением
при создании трехмерных объектов:

· Retain defining geometry – сохранять определяющие объекты;
· Delete profile curves – удалить кривые профиля;
· Delete profile and path curves – удалить профиль и криволинейные траектории;
· Prompt to delete profile curves – запрос удаления профиля и криволинейных траекторий;
· Prompt to delete profile and path curves – запрос удаления кривых профиля;
– U isolines on surfaces and meshes – установка значения U-изолинии на поверхностях и

сетях;
– V isolines on surfaces and meshes – установка значения V-изолинии на поверхностях и

сетях.
• В области 3D Navigation определяются параметры навигации:
– Reverse mouse wheel zoom – установка реверса зумирования колесиком мыши;
– кнопка Walk and Fly… – загрузка диалогового окна Walk and Fly Settings (рис. 3.24),

позволяющего установить параметры обхода и облета:

Рис. 3.24. Диалоговое окно установки параметров обхода и облета

· в области Settings – вариант показа окна команд: When entering walk and fly modes – при
переходе в режимы обхода и облета, Once per session – раз за сеанс, Never – не показывать. А
также Display Position Locator window – показывать диалоговое окно локатора положения;

· в области Current drawing settigs определяются параметры текущего чертежа: Walk/fly
step size: – величина шага обхода/облета в единицах чертежа, Steps per second: – количество
шагов в секунду;
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– кнопка Animation… – загрузка диалогового окна Animation Settings (рис. 3.25), позво-
ляющего установить параметры анимации:

Рис. 3.25. Диалоговое окно установки параметров анимации

· в области Settings – режимы: Visual style: – визуальный стиль (обычный, тонирование;
трехмерный скрытый, трехмерный каркас, концептуальный, реалистичный; черновой, низкий,
средний, высокий, презентационный), Resolution: – разрешение, Frame rate (FPS): – частота
кадров в секунду, Format: – формат.
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Настройка параметров выбора объектов

 
Вкладка настройки параметров выбора объектов Selection диалогового окна Options,

показанная на рис. 3.26, позволяет сделать следующие назначения.

Рис. 3.26. Диалоговое окно настройки параметров выбора объектов

• В области Pickbox Size определяется размер прицела.
• В области Selection Preview определяются параметры просмотра выбранных объектов:
– When a command is active – когда активна команда;
– When no command is active – если нет активных команд;
– кнопка Visual Effect Settings… загружает одноименное диалоговое окно (рис. 3.27),

позволяющее определить параметры визуальных эффектов:
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Рис. 3.27. Диалоговое окно настройки параметров визуальных эффектов

· в области Selection Preview Effect – задать эффект просмотра выбранных объектов:
Dash – пунктиром, Thicken – с приданием толщины, Both – оба варианта. Кнопка Advanced
Options загружает диалоговое окно Advanced Preview Options (рис. 3.28), позволяющее настро-
ить дополнительные параметры и настроить фильтр просмотра выбранных объектов: Exclude
objects on locked layers – исключить объекты на заблокированных слоях. Исключить: Xrefs –
внешние ссылки, Tables – таблицы, Groups – группы, Multiline text – многострочный текст,
Hatches – штриховки;

Рис. 3.28. Диалоговое окно настройки дополнительных параметров просмотра выбран-
ных объектов

· в области Area Selection Effect – задать эффект выбранной области: Indicate selection
area – указать область, Window selection color: – цвет рамки выбора, Crossing selection color: –
цвет зачеркивания выбранной области, Selection area opacity: – степень затенения выбранной
области.

• В области Selection Modes определяются режимы выбора:
– Noun/verb selection – предварительный выбор;
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– Use Shift to add to selection – использование клавиши Shift для добавления;
– Press and drag – динамическая рамка;
– Implied windowing – выбор с помощью рамки;
– Object grouping – группа объектов;
– Associative Hatch – ассоциативная штриховка.
• В области Grip Size определяется размер ручек.
• В области Grips определяются параметры ручек:
– Unselected grip color: – цвет невыбранных ручек;
– Selected grip color: – цвет выбранных ручек;
– Hover grip color: – цвет ручки под курсором;
– Enable grips – включить ручки;
– Enable grips within blocks – ручки внутри блоков;
– Enable grip tips – подсказки к ручкам;
– Object selection limit for display of grips – предельное количество выбранных объектов

для показа ручек.
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Настройка профилей

 
Вкладка Profiles диалогового окна Options используется для создания профилей и сохра-

нения в них параметров среды рисования (рис. 3.29). Профиль – набор параметров настройки
AutoCAD, сохраненный с уникальным именем. Один из профилей является текущим; он опре-
деляет настройки рабочей среды рисования. Пользователи, входящие в систему под одним име-
нем, могут загружать свои настройки из различных профилей. По умолчанию AutoCAD запи-
сывает текущие параметры в профиль без имени Unnamed Profile. Имена текущего профиля и
рисунка всегда выводятся над названиями вкладок диалогового окна Options.

Рис. 3.29. Диалоговое окно настройки профилей

На вкладке Profiles можно осуществлять следующие настройки:
• в области имеющихся профилей Available Profiles: – выбирать необходимый из перечня

доступных;
• нажатием кнопки Set Current – устанавливать выбранный профиль в качестве текущего;
• используя кнопку Add to List… – добавлять новый профиль;
• с помощью кнопки Renane… – переименовывать имеющиеся профили;
• с помощью кнопки Delete – удалять имеющиеся профили;
• с помощью кнопки Export… – экспортировать настройки текущего профиля во внеш-

ний ARG-файл;
• после щелчка на кнопке Import… – импортировать настройки профиля из внешнего

ARG-файла;
• кнопкой Reset – сбрасывать настройки.
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Глава 4

Системы координат
 

Ввод координат
Динамический ввод координат
Декартовы и полярные координаты
Формирование точек методом «направление – расстояние»
Определение трехмерных координат
Правило правой руки
Ввод трехмерных декартовых координат
Ввод цилиндрических координат
Ввод сферических координат
Координатные фильтры
Определение пользовательской системы координат
Выбор пользовательской системы координат в пространстве
Работа с ПСК на видовых экранах
Выбор стандартной пользовательской системы координат
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Ввод координат

 
Когда программа AutoCAD запрашивает точку, команда ожидает ввода координат какой-

либо точки текущего рисунка. В AutoCAD может быть включен контроль лимитов рисунка,
осуществляемый командой LIMITS. В этом случае, если введенная точка выходит за пределы
рисунка, AutoCAD выдает сообщение:

** Outside limits – вне лимитов
и отвергает введенную точку.
В представлении рисунка во внутренней графической базе данных координаты каждой

точки задаются с точностью не менее 14 значащих цифр.
Ввод координат в AutoCAD может осуществляться двумя способами:
• непосредственно с клавиатуры, путем указания численных значений;
• с использованием графического маркера (курсора), который движется по экрану с

помощью устройства указания. Ввод координат осуществляется щелчком левой кнопкой
мыши.

Как следствие, в строке состояния, расположенной внизу рабочего стола, происходит
отображение текущих значений координат. Существует три режима отображения координат:

• динамический, при котором обновление координат происходит постоянно по мере пере-
мещения указателя мыши;

• статический, при котором координаты обновляются только после указания точки;
• режим относительных координат, формат расстояние<угол , при котором обновле-

ние значений происходит по мере перемещения указателя мыши во время рисования объекта,
содержащего более одной точки.

Включение отображения координат в строке состояния осуществляется с помощью
системной переменной COORDS. Значение 0 соответствует статическому отображению, 1 –
динамическому, 2 – относительному.

Для определения координат точек существующих объектов (например, точки пересече-
ния или середины отрезка) можно воспользоваться командой ID. При этом следует применять
объектную привязку, иначе полученные координаты могут оказаться неточными.

Для определения координат сразу всех характерных точек объекта удобно использовать
команду LIST. Еще один метод получения координат характерных точек – выбор объекта с
помощью ручек. Ручки представляют собой маленькие прямоугольники, располагающиеся в
характерных точках объектов, например конечных точках и середине отрезка. При привязке
курсора к одной из ручек в поле координат строки состояния отображаются ее координаты.

Для удобства ввода координат можно использовать:
• ортогональный режим, когда изменение координат происходит только по оси X или Y.

Ортогональный режим включается либо нажатием функциональной клавиши F8, либо щелч-
ком на кнопке

Ortho Mode в строке состояния;
• привязку к узлам невидимой сетки, определенной с некоторым шагом по осям X и Y.

Такую шаговую привязку можно установить либо нажав функциональную клавишу F9, либо
щелкнув на кнопке



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

112

Snap Mode в строке состояния. Если включен шаг привязки, то при перемещении мыши
перекрестье будет «перепрыгивать» с одного узла невидимой сетки на другой.

Значения координат независимо от способа ввода всегда связаны с некоторой системой
координат. По умолчанию в AutoCAD используется так называемая мировая система коорди-
нат, МСК – World Coordinate System (WCS). Она определена так, что ось OX направлена слева
направо, ось OY – снизу вверх, ось OZ – перпендикулярно экрану, вовне. Как правило, для
выполнения конкретного проекта удобнее определить пользовательскую систему координат,
ПСК – User Coordinate System (UCS), которую можно сместить относительно мировой и/или
повернуть под любым углом. Допускается существование нескольких пользовательских систем
координат, и в любой момент возможен переход от одной к другой.

Никакие изменения МСК не допускаются. AutoCAD позволяет одновременно исполь-
зовать и координаты, связанные с текущей ПСК, и координаты, связанные с МСК. При этом
для МСК при вводе с клавиатуры значению координат должен предшествовать символ «звез-
дочка» (*).
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Динамический ввод координат

 
С помощью функции динамического ввода значения координат можно вводить не в

командной строке, а в поле всплывающей подсказки, которая отображается рядом с курсором
и динамически обновляется по мере перемещения курсора. Функция динамического ввода
включается и отключается в строке состояния кнопкой

Dynamic Input.
Существует два типа динамического ввода:
• ввод значений координат с помощью мыши;
• ввод размеров для линейных и угловых значений.
Настройка динамического ввода осуществляется в диалоговом окне режимов рисования

Drafting Settings, вкладка Dynamic Input (рис. 4.1), которое вызывается из падающего меню
Tools → Drafting Settings… или из контекстного меню щелчком правой кнопки мыши в строке
состояния на кнопке Dynamic Input и выбором пункта Settings….

Рис. 4.1. Диалоговое окно настройки динамического ввода

Здесь настраиваются следующие параметры динамического ввода.
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• Enable Pointer Input – включить ввод с помощью мыши.
• Enable Dimension Input where possible – включить ввод размеров, где возможно.
• В области Pointer Input кнопкой Settings… загружается диалоговое окно Pointer Input

Settings (рис. 4.2), позволяющее настроить параметры ввода с помощью мыши:

Рис. 4.2. Диалоговое окно настройки параметров ввода с помощью мыши

– в области Format – назначить использование по умолчанию для второй или следующих
точек:

· Polar format – полярный формат;
· Cartesian format – декартов формат;
· Relative coordinates – относительные координаты;
· Absolute coordinates – абсолютные координаты;
– в области Visibility – показывать подсказки для координат:
· As soon as I type coordinate data – одновременно с вводом координатных данных;
· When a command asks for a point – когда команда содержит запрос для точки;
· Always – even when not in command – всегда, даже если не в команде.
• В области Dimension Input кнопкой Settings… загружается диалоговое окно настройки

параметров ввода размеров Dimension Input Settings (рис. 4.3), позволяющее установить види-
мость при растяжке ручек:
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Рис. 4.3. Диалоговое окно настройки параметров ввода размеров

– Show only 1 dimension input field at a time – показывать одновременно только одно поле
для ввода размеров;

– Show 2 dimension input fields at a time – показывать одновременно два поля для ввода
размеров;

– Show the following dimension input fields simultaneously: – показывать одновременно сле-
дующие поля для ввода размеров:

· Resulting Dimension – результирующий размер;
· Length Change – изменение длины;
· Absolute Angle – абсолютный угол;
· Angle Change – изменение угла;
· Arc Radius – радиус дуги.
• В области Dynamic Prompts – настроить динамические подсказки:
– Show command prompting and command input near the crosshairs – показывать подсказку

для ввода команды и вводимую команду рядом с перекрестьем;
– в динамической подсказке для доступа к параметрам необходимо нажать клавишу ↓

(стрелка вниз).
• Кнопка Drafting Tooltip Appearance… загружает диалоговое окно Tooltip Appearance

(рис. 4.4), позволяющее настроить внешний вид подсказок на чертеже:
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Рис. 4.4. Диалоговое окно настройки внешнего вида подсказок на чертеже

– Model Preview – предварительный просмотр модели;
– Layout Preview – предварительный просмотр листа;
– Colors… – выбор цвета в диалоговом окне Drawing Window Colors (см. рис. 3.3);
– Size – установка размера;
– Transparency – установка прозрачности;
– Override OS settings for all drafting tooltips – заменить параметры ОС для всех подсказок

на чертеже;
– Use settings only for Dynamic Input tooltips – заменить параметры только для подсказок

динамического ввода;
– кнопка Options… загружает одноименное диалоговое окно, вкладку Drafting (см. рис.

3.19).
При использовании ввода с помощью мыши в области рисования при перемещении кур-

сора будут отображаться значения координат, для ввода которых необходимо сначала ввести
значение, затем для перехода к следующей подсказке нажать клавишу TAB и после этого ввести



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

117

значение следующей координаты. При определении точки первая координата является абсо-
лютной, Формат второй и следующих точек – относительные полярные координаты. Если тре-
буется ввести абсолютное значение, необходимо перед ним ввести знак #.
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Декартовы и полярные координаты

 
В двумерном пространстве точка определяется в плоскости XY, которая называется

также плоскостью построений. Ввод координат с клавиатуры возможен в виде абсолютных и
относительных координат.

Ввод абсолютных координат производится в следующих форматах:
• декартовы (прямоугольные) координаты. При этом для определения двумерных и трех-

мерных координат применяются три взаимно перпендикулярные оси: X, Y и Z. Для ввода коор-
динат указывается расстояние от точки до начала координат по каждой из этих осей, а также
направление (+ или -). При начале нового рисунка текущей системой всегда является мировая
система координат World Coordinate System (WCS), следовательно, ось X направлена горизон-
тально, ось Y – вертикально, а ось Z перпендикулярна плоскости XY;

• полярные координаты. При вводе координат указывается расстояние, на котором рас-
полагается точка от начала координат, а также величина угла, образованного полярной осью
и отрезком, мысленно проведенным через данную точку и начало координат. Угол задается
в градусах против часовой стрелки. Значение 0 соответствует положительному направлению
оси OX.

Относительные координаты задают смещение от последней введенной точки. При вводе
точек в относительных координатах можно использовать любой формат записи в абсолютных
координатах: @dx,dy – для декартовых, @r<A – для полярных.

Относительные декартовы координаты удобно применять в том случае, если известно
смещение точки относительно предыдущей.

 
Пример. Построение в абсолютных координатах

 
Постройте многоугольник, задавая точки в абсолютных координатах (рис. 4.5).

Рис. 4.5. Построение многоугольника

Запустите команду формирования отрезка LINE, вызвав ее из падающего меню Draw →
Line или щелкнув на пиктограмме Line на панели инструментов Draw. Ответьте на запросы:

_LINE
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: 190,20 – точка 2
Specify next point or [Undo]: 190,100 – точка 3
Specify next point or [Close/Undo]: 130,40 – точка 4
Specify next point or [Close/Undo]: 130,100 – точка 5
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Specify next point or [Close/Undo]: Close – замкните линию
 

Пример. Построение в относительных координатах
 

Постройте многоугольник, показанный на рис. 4.5, задавая точки в относительных коор-
динатах.

Запустите команду формирования отрезка LINE, вызвав ее из падающего меню Draw →
Line или щелкнув на пиктограмме Line на панели инструментов Draw. Ответьте на следующие
запросы (символ @ вводится при одновременном нажатии клавиш Shift+2):

_LINE
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: @150,0 – в точку 2 относительно точки 1
Specify next point or [Undo]: @0,80 – в точку 3 относительно точки 2
Specify next point or [Close/Undo]: @-60,-60 – в точку 4 относительно

точки 3
Specify next point or [Close/Undo]: @0,60 – в точку 5 относительно точки 4
Specify next point or [Close/Undo]: Close – замкните линию

 
Пример. Построение в полярных координатах

 
Постройте многоугольник, задавая точки в полярных координатах (см. рис. 4.5).

Запустите команду формирования отрезка LINE, вызвав ее из падающего меню Draw →
Line или щелкнув на пиктограмме Line на панели инструментов Draw. Ответьте на запросы:

_LINE
Specify first point: 40,20 – точка 1
Specify next point or [Undo]: @150<0 – в точку 2 относительно точ ки 1
Specify next point or [Undo]: @80<90 – в точку 3 относительно точки 2
Specify next point or [Close/Undo]: @85<-135 – в точку 4 относительно

точки 3
Specify next point or [Close/Undo]: @60<90 – в точку 5 относительно

точки 4
Specify next point or [Close/Undo]: Close – замкните линию
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Формирование точек методом «направление – расстояние»

 
Вместо ввода координат допускается использование прямой записи расстояния , что

особенно удобно для быстрого ввода длины линии. Такой ввод может производиться во
всех командах, кроме тех, которые предполагают указание просто действительного значения,
например в командах построения массива ARRAY, разметки MEASURE и деления объекта
DIVIDE. При использовании прямой записи расстояния в ответ на запрос точки достаточно
переместить мышь в нужном направлении и ввести числовое значение в командной строке.
Например, если таким способом задается отрезок, то он строится путем указания числового
значения длины и направления под определенным углом. При включенном ортогональном
режиме этим способом очень удобно рисовать перпендикулярные отрезки.
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Определение трехмерных координат

 
Трехмерные координаты задаются аналогично двумерным, но к двум составляющим по

осям X и Y добавляется третья величина – по оси Z. В трехмерном пространстве аналогично
двумерному моделированию можно использовать абсолютные и относительные координаты, а
также цилиндрические и сферические, которые схожи с полярными в двумерном пространстве.

Значения координат независимо от способа ввода всегда связаны с некоторой системой
координат. При работе в трехмерном пространстве значения x, y и z указывают либо в мировой
системе координат World Coordinate System (WCS), либо в пользовательской User Coordinate
System (UCS).
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Правило правой руки

 
При работе в трехмерном пространстве в AutoCAD все системы координат формиру-

ются по правилу правой руки. Оно определяет положительное направление оси Z трехмерной
системы координат при известных направлениях осей X и Y, а также положительное направ-
ление вращения вокруг любой из осей трехмерных координат.

Для определения положительных направлений осей необходимо поднести тыльную сто-
рону кисти правой руки к экрану монитора и направить большой палец параллельно оси X, а
указательный – по оси Y. Если согнуть средний палец перпендикулярно ладони, как показано
на рис. 4.6 справа, то он будет указывать положительное направление оси Z.

Рис. 4.6. Правило правой руки

Для определения положительного направления вращения следует сориентировать боль-
шой палец правой руки в положительном направлении оси и согнуть остальные пальцы, как
показано на рис. 4.6 слева. Положительное направление вращения совпадает с направлением,
указываемым согнутыми пальцами.
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Ввод трехмерных декартовых координат

 
Трехмерные декартовы координаты (x, y, z) вводятся аналогично двумерным (x, y).

Дополнительно к координатам по осям X и Y необходимо ввести еще и значение по оси Z. На
самом деле в AutoCAD не существует двумерных координат, и если введены значения только x
и y, это означает, что отсутствующая координата z берется по умолчанию равной нулю (систем-
ная переменная THICKNESS). При указании декартовых трехмерных координат с клавиатуры
вводятся три числа через запятую, например:

3,5,2
В трехмерном пространстве, так же как и в двумерном, широко используются и абсолют-

ные координаты (отсчитываемые от начала координат), и относительные (отсчитываемые от
последней указанной точки). Признак относительных координат – символ @ перед координа-
тами вводимой точки, которая в этом случае берется относительно последней введенной точки.
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Ввод цилиндрических координат

 
Ввод цилиндрических координат аналогичен указанию полярных координат на плоско-

сти. Дополнительно появляется значение, определяющее координату z по оси Z, перпендику-
лярной плоскости XY. Цилиндрические координаты описывают расстояние от начала системы
координат (или от предыдущей точки в случае с относительными координатами) до точки на
плоскости XY, угол относительно оси X и расстояние от точки до плоскости XY. Угол задается
в градусах.

На рис. 4.7 показана точка с координатами 7<30,5. Эта точка лежит на расстоянии 7
единиц от начала системы координат в плоскости XY, под углом 30° к оси X на плоскости
XY и имеет координату Z, равную 5. Относительные цилиндрические координаты строятся
так же, как и абсолютные, просто воображаемое начало координат переносится в последнюю
введенную точку.

Рис. 4.7. Указание цилиндрических координат
 

Пример. Построение в цилиндрических координатах
 

Цилиндрические координаты применяются при вводе точек трехмерного пространства
реже, чем декартовы. Их использование бывает необходимо, например, для построения спи-
ральных объектов. В следующем примере с помощью команды 3DPOLY формируется двух-
витковая спираль.

_3DPOLY
Specify start point of polyline: 0,0,0 – точка 1
Specify endpoint of line or [Undo]: @40<45,20 – точка 2
Specify endpoint of line or [Undo]: @40<135,20 – точка 3
Specify endpoint of line or [Close/Undo]: @40<-135,20 – точка 4
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Specify endpoint of line or [Close/Undo]: @40<-45,20 – точка 5
Specify endpoint of line or [Close/Undo]: @40<45,20 – точка 6
Specify endpoint of line or [Close/Undo]: @40<135,20 – точка 7
Specify endpoint of line or [Close/Undo]: @40<-135,20 – точка 8
Specify endpoint of line or [Close/Undo]: @40<-45,20 – точка 9
Specify endpoint of line or [Close/Undo]: Close – замкните линию

При выполнении описанного примера следует учесть, что не обязательно вводить с кла-
виатуры повторяющиеся строки координат. Ранее введенные строки текста запоминаются в
буфере строк, благодаря чему их удобно вызывать в диалоговую область с помощью клавиш
↑ и ↓ на функциональной клавиатуре. Например, повторный ввод строки @40<45,20 можно
осуществить, несколько раз нажав клавишу ↑ (пока не появится нужная строка), и затем вве-
сти ее клавишей Enter. Но это не единственная возможность использования данного приема:
допускается также редактирование «поднятой» строки с помощью клавиш ← и →, добавление
символов с клавиатуры и удаление символов с помощью клавиши Backspace.
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Ввод сферических координат

 
Ввод сферических координат в трехмерном пространстве также подобен вводу полярных

координат на плоскости. Положение точки определяется ее расстоянием от начала координат
текущей ПСК, углом к оси X в плоскости XY и углом к плоскости XY. Все координаты разде-
ляются символом <. Угол задается в градусах.

На рис. 4.8 показана точка с координатами 7<30<45. Эта точка лежит на расстоянии 7
единиц от начала текущей ПСК, под углом 30° к оси X в плоскости XY и под углом 45° к
плоскости XY.

Рис. 4.8. Указание сферических координат
 

Пример. Ввод сферических координат
 

Сферические координаты используются для получения точек на сферической поверхно-
сти или, например, в случаях построения трубопровода и т. п., когда наиболее важна длина
строящегося объекта, а не его ориентация. В нижеописанном примере командой 3DPOLY фор-
мируется пятиугольник с вершинами, лежащими на сфере, радиус которой равен 50 единицам.

_3DPOLY
Specify start point of polyline: 50<20<-20 – точка 1
Specify endpoint of line or [Undo]: 50<30<5 – точка 2
Specify endpoint of line or [Undo]: 50<15<20 – точка 3
Specify endpoint of line or [Close/Undo]: 50<-15<20 – точка 4
Specify endpoint of line or [Close/Undo]: 50<-30<5 – точка 5
Specify endpoint of line or [Close/Undo]: Close – замкните линию
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Координатные фильтры

 
Координатные фильтры – это способ указания новых точек в пространстве с использо-

ванием отдельных координат уже имеющихся на чертеже объектов. Наибольшее распростра-
нение координатные фильтры получили при вводе координат с помощью мыши. Их примене-
ние позволяет задавать значение одной координаты, временно игнорируя значения других. Для
указания фильтра в командной строке используется формат:

<координата>
где <координата> – один из символов x, y, z или некоторое их сочетание.
Существует набор из шести фильтров: .x, .y, .z, .xy, .xz и .yz. Если, например, ввести .x,

AutoCAD запросит указать недостающие координаты по осям Y и Z.
Координатные фильтры можно вводить в командной строке в ответ на запрос ввода

точки.
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Определение пользовательской системы координат

 
Как было сказано выше, в AutoCAD существуют: мировая система координат World

Coordinate System, WCS, и пользовательская система координат User Coordinate System, UCS.
Ось X мировой системы координат направлена горизонтально, ось Y – вертикально, а ось Z
проходит перпендикулярно плоскости XY. Начало координат – это точка пересечения осей X и
Y; по умолчанию она совмещается с левым нижним углом рисунка. В любой текущий момент
активна только одна система координат, которую принято называть текущей. В ней коорди-
наты определяются любым доступным способом.

Основное отличие мировой системы координат от пользовательской заключается в том,
что мировая система координат может быть только одна (для каждого пространства модели и
листа) и она неподвижна. Применение пользовательской системы координат не имеет прак-
тически никаких ограничений. Она может быть расположена в любой точке пространства под
любым углом к мировой системе координат. Разрешается определять, сохранять и восстанав-
ливать неограниченное количество ПСК. Проще выровнять систему координат с существую-
щим геометрическим объектом, чем определять точное размещение трехмерной точки. ПСК
обычно используется для работы с несмежными фрагментами рисунка. Поворот ПСК упро-
щает указание точек на трехмерных или повернутых видах. Узловые точки и базовые направле-
ния, определяемые режимами шаговой привязки SNAP, сетки GRID и ортогонального режима
ORTHO, поворачиваются вместе с ПСК.

При работе в ПСК допускается поворачивать ее плоскость XY и смещать начало коорди-
нат. Все они при вводе отсчитываются относительно текущей пользовательской системы коор-
динат. Соответствующая пиктограмма дает возможность судить о положении и ориентации
текущей ПСК, помогая визуализировать эту ориентацию относительно мировой системы коор-
динат, а также относительно объектов, содержащихся в рисунке.

Пиктограмма ПСК всегда изображается в плоскости XY текущей ПСК и указывает поло-
жительное направление осей X и Y. Сама пиктограмма может располагаться как в начале
пользовательской системы координат, так и в другом месте. Эту позицию регулирует команда
управления пиктограммой системы координат UCSICON. С помощью той же команды можно
выбрать одну из пиктограмм, размер, цвет, тип стрелок осей и толщины линий которых можно
изменить (рис. 4.9).

Рис. 4.9. Варианты пиктограмм системы координат

Различные варианты пиктограмм ПСК используются для облегчения восприятия изоб-
ражения (рис. 4.10).
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Рис. 4.10. Варианты пиктограмм системы координат

Появление символа «плюс» (+) в нижнем левом углу пиктограммы указывает на ее рас-
положение в начале ПСК. Пользовательская система координат используется для перемещения
начала системы координат и/или изменения ориентации осей системы координат в простран-
стве, что значительно упрощает процесс создания и редактирования объектов. При создании
объекта удобно поместить начало системы координат в базовую точку объектов, особенно если
в данной точке формируется много объектов.

Пиктограмма с изображением сломанного карандаша говорит о том, что плоскость XY
практически параллельна направлению взгляда. В этом случае при указании значений коор-
динат с помощью мыши происходит выбор точек с нулевыми координатами z, что обычно не
соответствует желанию пользователя. Перед вводом точек или редактированием модели по
виду пиктограммы следует оценить угол между направлением взгляда и пиктограммой ПСК:
если этот угол мал, точный выбор точек с помощью мыши или другого манипулятора затруд-
нителен.
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Выбор пользовательской системы

координат в пространстве
 

Для изменения положения ПСК применяются следующие способы:
• указание новой плоскости XY или новой оси Z;
• ввод нового начала координат;
• совмещение ПСК с имеющимся объектом;
• совмещение ПСК с гранью тела;
• совмещение ПСК с направлением взгляда;
• поворот ПСК вокруг одной из ее осей;
• расположение плоскости XY ПСК перпендикулярно выбранному в качестве оси Z

направлению;
• восстановление ранее сохраненной ПСК для совмещения с МСК;
• применение имеющейся ПСК к любому видовому экрану;
• возврат к предыдущей ПСК.
Размещение, перемещение, вращение и отображение пользовательских систем координат

производится с помощью команды UCS. Вызвать эту команду или варианты ее исполнения
можно из командной строки или с падающего меню Tools → New UCS. Наиболее удобным
представляется вызов с плавающей панели инструментов UCS – рис. 4.11.

Рис. 4.11. Панель инструментов UCS

UCS – определение новой пользовательской системы координат. Запрос команды UCS:
Current ucs name: *WORLD* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/

Z/ZAxis] <World>: – задать ключ

World – переход к мировой системе координат;

UCS Previous – восстановление предыдущей ПСК. При этом сохраняется десять послед-
них определенных ПСК;

Face UCS – определение пользовательской системы координат путем простого указания
на грань;
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Object – выравнивание системы координат по существующему объекту;

View – выравнивание системы координат в направлении текущего вида, то есть опреде-
ление новой системы координат с плоскостью XY, перпендикулярной направлению вида (иначе
говоря, параллельно экрану);

Origin – размещение ПСК в начале координат;

Z Axis Vector – определение нового положительного направления оси;

3 Point – определение нового начала координат и направления осей X и Y по трем точкам;

X – поворот системы координат вокруг оси X;

Y – поворот системы координат вокруг оси Y;

Z – поворот системы координат вокруг оси Z;

Apply – применение текущей ПСК к выбранному видовому экрану.
Изменение текущей ПСК не влияет на изображение рисунка на экране, если не включена

системная переменная UCSFOLLOW; в противном случае показывается вид в плане текущей
ПСК.

Если пиктограмма ПСК активизирована, она перерисовывается в соответствии с ориен-
тацией новой системы координат.

С ПСК связаны следующие системные переменные.
• UCSXDIR, UCSYDIR определяют направление осей X и Y в мировых координатах.

Переменные доступны только для чтения.
• UCSNAME определяет имя текущей ПСК.
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• WORLDUCS равна 1, если текущая ПСК совпадает с мировой системой координат, и
0 – в противном случае.

• UCSORG определяет начало координат текущей системы координат для текущего про-
странства.

Управление системами координат осуществляется с помощью команды DDUCS, вызыва-
емой из падающего меню Tools → Named UCS… или щелчком на пиктограмме Named UCS…
на панели инструментов UCSII. На вкладке Named UCSs диалогового окна UCS можно при-
своить любой пользовательской системе координат уникальное имя.

В дальнейшем, открыв вкладку именованных ПСК Named UCSs диалогового окна UCS,
можно по ранее заданному имени восстановить пользовательскую систему координат. На рис.
4.12 показана вкладка Named UCSs этого окна с ранее созданными пользовательскими систе-
мами координат. Чтобы сделать систему координат текущей, необходимо навести указатель
мыши на ее имя и щелкнуть на кнопке Set Current.

Рис. 4.12. Диалоговое окно управления именованными ПСК

Чтобы добавить новую пользовательскую систему координат, необходимо присвоить
текущей ПСК со стандартным именем Unnamed уникальное название. Для этого достаточно
щелкнуть на имени текущей ПСК и набрать новое с клавиатуры в появившемся поле. Другие
стандартные названия – World и Previous – зарезервированы для мировой системы координат
и для той, которая использовалась перед текущей. Именованные пользовательские системы
координат применяются в случаях, когда установленная ПСК, с которой неоднократно при-
дется работать в дальнейшем, не совпадает со стандартной. Если пользовательские системы
координат были определены как именованные, их легко восстановить в диалоговом окне UCS
на вкладке Named UCSs.

Для удаления пользовательской системы необходимо навести на ее имя указатель мыши
и нажать клавишу Delete.
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При щелчке на кнопке Details раскрывается подробное диалоговое окно UCS Details, в
котором отражена вся информация о координатах точки начала и направлении осей относи-
тельно текущей системы координат по каждой именованной ПСК (рис. 4.13).

Рис. 4.13. Диалоговое окно UCS Details
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Работа с ПСК на видовых экранах

 
На видовые экраны выводятся различные виды модели. Например, иногда требуется

создать четыре видовых экрана для показа модели сверху, справа, слева и снизу. Чтобы повы-
сить удобство работы, для каждого видового экрана можно задать и сохранить отдельную ПСК.
В этом случае при переключении между видовыми экранами не происходит потери информа-
ции о ПСК каждого из них.

Сохранение ПСК для каждого видового экрана обеспечивается системной переменной
UCSVP. Если для видового экрана она установлена в 0, то ПСК этого видового экрана всегда
совпадает с ПСК текущего активного видового экрана. Если для видового экрана системная
переменная UCSVP установлена в 1, то заданная для этого экрана ПСК запоминается и не
изменяется при переходе на другой.

Вкладка Settings диалогового окна UCS позволяет устанавливать различные режимы
отображения пиктограммы ПСК. Причем параметры отображения можно задавать либо
отдельно для текущего видового экрана, либо сразу для всех активных видовых экранов теку-
щего рисунка. Здесь же можно указать, следует ли сохранять систему координат вместе с видо-
вым экраном, а кроме того, нужно ли на видовом экране всегда показывать вид модели в плане.
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Выбор стандартной пользовательской системы координат

 
Ориентацию текущей ПСК в зависимости от мировой системы координат, предыдущей

ПСК или ПСК, установленной для текущего вида, можно изменить в диалоговом окне UCS,
на вкладке Orthographic UCSs, показанной на рис. 4.14. При этом достаточно выбрать объект
и выполнить команду DDUCSP, вызываемую из падающего меню Tools → Named UCS….

Рис. 4.14. Диалоговое окно стандартных ПСК

С помощью данной команды можно определить новую пользовательскую систему коор-
динат по отношению либо к мировой, либо к текущей, выбрав соответствующий слайд в диало-
говом окне. Команду DDUCSP используют в основном для переноса пользовательской системы
координат из одной ортогональной проекции в другую.

В AutoCAD имеется шесть стандартных ортогональных ПСК: верхняя, нижняя, перед-
няя, задняя, левая и правая. По умолчанию параметры ортогональных ПСК рассчитываются
относительно МСК.

Стандартной системой координат удобно пользоваться при переходе от одной ортого-
нальной проекции трехмерного объекта к другой. Обычно эти проекции располагаются в
соседних окнах и признаком правильной установки ПСК считается отображение в нужном
окне правильной пиктограммы системы координат (ось X направлена вправо, ось Y – вверх).
Так как набор стандартных систем координат ограничен, оптимальным является табличный
способ их определения.
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Пример. Пользовательская система координат

 
В нижеописанном примере необходимо перенести пользовательскую систему координат

в другую точку на рабочем поле чертежа. После перемещения пользовательской системы коор-
динат из точки мировой системы координат в пиктограмме пропадает символ W. О том, что
пиктограмма находится в точке пользовательской системы координат, свидетельствует значок
«плюс» (+).

Запустите команду UCS, вызвав ее из падающего меню Tools → New UCS → Origin или
щелкнув на пиктограмме Origin на панели инструментов UCS. Ответьте на запросы:

_UCS
Current ucs name: *WORLD* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/

Z/ZAxis]
<World>: _o – переход в режим смещения начала координат
Specify new origin point <0,0,0>: 195,140 – координаты точки смещения

начала координат
Выполните поворот пользовательской системы координат:

_UCS
Current ucs name: *NO NAME* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/

Z/ZAxis]
<World>: _z – переход в режим поворота вокруг оси Z
Specify rotation angle about Z axis <90>: 30 – угол поворота вокруг оси

Z в градусах

Для возвращения в мировую систему координат запустите команду UCS, вызвав ее из
падающего меню Tools → New UCS → World или щелкнув на пиктограмме World на панели
инструментов UCS. Команда выдаст запросы:

_UCS
Current ucs name: *NO NAME* – текущая ПСК
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/World/X/Y/

Z/ZAxis]
<World>: _w – возвращение в мировую систему координат
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Глава 5

Свойства примитивов
 

Разделение рисунка по слоям
Управление видимостью слоя
Блокировка слоев
Цвет линии
Тип линии
Вес (толщина) линии
Фильтрация слоев
Использование свойств слоев
Копирование свойств объектов
Палитра свойств объектов

Слои подобны лежащим друг на друге прозрачным листам кальки. На различных слоях
группируются различные типы данных рисунка. Любой графический объект рисунка обладает
такими свойствами, как цвет, тип и вес (толщина) линии, стиль печати. При создании объекта
значения этих свойств берутся из описания слоя, на котором он создается. При необходимости
свойства любого объекта можно изменить. Использование цвета позволяет различать сходные
элементы рисунка. Применение линий различных типов помогает быстро распознавать такие
элементы, как осевые или скрытые линии. Вес (толщина) линии определяет толщину начерта-
ния объекта и используется для повышения наглядности рисунка. Расположение объектов на
различных слоях позволяет упростить многие операции по управлению данными рисунка.

Инструменты, предназначенные для работы со свойствами объектов, приведены на пане-
лях инструментов Layers и Properties (см. рис. 2.11 и 2.12).
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Разделение рисунка по слоям

 
Построенные объекты всегда размещаются на определенном слое. Например, один слой

может содержать несущие конструкции, стены, перегородки здания, другой слой – коммуни-
кации, электрику и т. п., а третий – мебель, элементы дизайна и т. д. Таким образом, комби-
нируя различные сочетания слоев, можно компоновать необходимые комплекты конструктор-
ской документации.

Слои могут применяться по умолчанию, а также определяться и именоваться самим
пользователем. С каждым слоем связаны заданные цвет, тип, вес (толщина) линии и стиль
печати. Размещая различные группы объектов на отдельных слоях, можно структурировать
рисунок. Послойная организация чертежа упрощает многие операции по управлению его дан-
ными.

Например, можно создать отдельный слой для размещения осевых линий, назначить
ему голубой цвет и штрихпунктирный тип линии CENTER. Впоследствии, если потребуется
построить осевую линию, достаточно будет переключиться на этот слой и начать рисование.
Таким образом, перед каждым построением осевых линий не требуется вновь устанавливать
их цвет и тип. Кроме того, при необходимости отображение слоя можно отключить. Возмож-
ность использования слоев – одно из главнейших преимуществ рисования в среде AutoCAD
перед черчением на бумаге.

Работая в пространстве листа или с плавающими видовыми экранами, можно устано-
вить видимость слоя индивидуально для каждого видового экрана. При необходимости показ
какого-либо слоя на экране или его вывод на печать можно легко отключить. Для всех слоев
действуют одни и те же установки лимитов рисунка, системы координат и коэффициента
экранного увеличения. Если какая-либо совокупность слоев используется часто, то эти слои,
цвета и типы линий рекомендуется сохранить в шаблоне. Слои представляют собой неграфи-
ческие объекты, которые также хранятся в файле рисунка.

Управление установками свойств слоев осуществляется в Диспетчере свойств слоев
Layer Properties Manager, показанном на рис. 5.1. Оно загружается из падающего меню Format
→ Layer… или щелчком на пиктограмме Layer Properties Manager на панели инструментов
Layers.

Рис. 5.1. Диалоговое окно управления слоями

При создании нового рисунка автоматически создается слой, названный 0, которому при-
сваиваются белый цвет, непрерывный тип линии Continuous, вес (толщина) линии Default, по
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умолчанию соответствующий толщине 0.25 mm. Этот слой не может быть удален и переиме-
нован.

Слои обладают следующими свойствами:
• Status – состояние слоя. Назначение слою статуса текущего;
• Name – имя слоя. Состоит из алфавитно-цифровой информации, включающей специ-

альные символы и пробелы;
• On – видимость слоя. При этом на экране изображаются только те примитивы, которые

принадлежат видимому слою, однако примитивы в скрытых слоях являются частью рисунка
и участвуют в регенерации;

• Freeze – замораживание слоя. Означает отключение видимости слоя при регенерации
и исключение из генерации примитивов, принадлежащих замороженному слою;

• Lock – блокировка слоя. Примитивы в блокированном слое отображаются, но их нельзя
редактировать. Блокированный слой можно сделать текущим, рисовать в нем, замораживать и
применять к его примитивам команды справок и объектную привязку;

• Color – цвет примитивов заданного слоя;
• Linetype – тип линии, которым будут отрисовываться все примитивы, принадлежащие

слою;
• Lineweight – вес (толщина) линии, которой будут отрисовываться все примитивы, при-

надлежащие слою;
• Plot Style – стиль печати для заданного слоя;
• Plot – разрешение/запрет вывода слоя на печать;
• New VP Freeze – замораживание на видовом экране;
• Description – описание слоя.

Для создания нового слоя необходимо щелкнуть на пиктограмме New Layer (Alt+N),
находящейся в верхней части окна Диспетчера свойств слоев Layer Properties Manager, пока-
занного на рис. 5.1.

Создается слой, по умолчанию названный Layer1. Далее все новые слои автоматически
именуются Layer2, Layer3 и т. д. – в порядке их создания. Чтобы присвоить слою уникальное
имя, необходимо двойным щелчком на текущем названии активизировать поле ввода текста,
а затем набрать имя с клавиатуры и нажать клавишу Enter.

Если при создании нового слоя выделен один из имеющихся, то новый слой наследует
его свойства. При необходимости свойства нового слоя можно изменить.

Все вновь создаваемые в AutoCAD объекты размещаются на текущем слое. При уста-
новке нового текущего слоя все объекты будут создаваться на нем с использованием назначен-
ных ему цвета, типа и веса линии. Замороженные и зависимые от ссылок слои нельзя сделать
текущими.

Для того чтобы сделать слой текущим, необходимо установить указатель мыши в графу
Status соответствующего слоя и щелкнуть на пиктограмме Set Current (Alt+C), находящейся в
верхней части окна Диспетчера свойств слоев Layer Properties Manager – см. рис. 5.1.

Сделать слой текущим можно двойным щелчком в графе Status соответствующего слоя
или с помощью системной переменной CLAYER.
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Установить текущий слой также можно, выбрав его из раскрывающегося списка управ-
ления слоями на панели инструментов (рис. 5.2).

Рис. 5.2. Список управления слоями

Кроме того, удобно устанавливать слой объекта текущим. Для этого следует выбрать этот
объект, а затем щелкнуть на пиктограмме Make Object’s Layer Current на панели инструментов
Layers.

Для удобства список слоев, выводимый в Диспетчере свойств слоев Layer Properties
Manager, можно упорядочить по любому свойству слоя. Допускается сортировка слоев по их
имени, видимости, цвету, типу, весу (толщине) линии или стилю печати. Для сортировки
списка достаточно щелкнуть на заголовке столбца того параметра, по которому нужно отсор-
тировать слои. Имена слоев могут быть отсортированы в алфавитном порядке, как прямом,
так и обратном.



Т.  Ю.  Соколова.  «AutoCAD 2009. Учебный курс»

141

 
Управление видимостью слоя

 
AutoCAD не отображает на экране объекты, расположенные на невидимых слоях, и не

выводит их на плоттер. Если при работе с деталями рисунка на одном или нескольких слоях
чертеж слишком загроможден, допускается отключение или замораживание неиспользуемых
слоев. Кроме того, чтобы запретить вывод на печать объектов определенных слоев, например
для вспомогательных линий, можно оставить эти слои видимыми, но отключить их вывод на
печать.

Выбор способа отключения показа слоев зависит от характера их использования и слож-
ности рисунка. Замораживать слои лучше в тех случаях, когда отображение слоя можно отклю-
чить на длительное время. При этом ускоряется выполнение команд зумирования ZOOM,
панорамирования PAN и VPORTS, упрощается выбор объектов и снижается время регенера-
ции сложных рисунков. Объекты замороженных слоев не обрабатываются функциями реге-
нерации, скрытия и тонирования. Разрешается замораживать и размораживать слои только
на активном плавающем видовом экране. При создании новых плавающих видовых экранов
можно автоматически замораживать на них определенные слои. Например, допустимо скрытие
размеров путем замораживания слоя с размерными линиями для всех новых видовых экра-
нов. Если же на новом видовом экране требуется отображение размеров, для этого видового
экрана можно разморозить соответствующий слой. Включение или отключение заморозки
слоев для новых видовых экранов не изменяет видимость слоев на уже имеющихся видовых
экранах. В тех случаях, когда требуются частые настройки отображения слоев, лучше исполь-
зовать их отключение, а не замораживание. При размораживании слоя выполняется регенера-
ция рисунка, после чего находящиеся на этом слое объекты становятся видимыми.

На печать могут выводиться только объекты включенных и размороженных слоев. Види-
мый слой печатается только в том случае, если не отключен его вывод на печать.

Объекты отключенных слоев участвуют в регенерации, хотя и не выводятся на экран или
плоттер. Чтобы сделать слой временно невидимым, его лучше отключить, а не заморозить, так
как при размораживании слоя всегда выполняется регенерация рисунка. При включении слоя
выполняется перерисовка объектов данного слоя.

Для отключения слоя необходимо в Диспетчере свойств слоев Layer Properties Manager,
показанном на рис. 5.1, навести указатель мыши на имя отключаемого слоя и затем щелк-
нуть на пиктограмме On. Аналогично происходит и замораживание слоя при щелчке на пик-
тограмме Freeze.

Кроме того, управлять видимостью слоев можно в раскрывающемся списке управления
слоями на панели инструментов Layers (см. рис. 5.2).

Предусмотрена возможность запрещать печать любого слоя, даже видимого. Если слой
содержит, например, только справочную информацию, то его вывод на печать можно отклю-
чить. Запрещение печати слоя не изменяет его отображения на экране. Поэтому запрет печати
удобно использовать для слоев, содержащих вспомогательные элементы построений. При этом
перед выводом рисунка на печать такие слои не требуется отключать. Запрет печати любого
слоя осуществляется в Диспетчере свойств слоев Layer Properties Manager – см. рис. 5.1. С этой
целью требуется выделить слои, для которых необходимо разрешить или запретить вывод на
печать, и щелкнуть на пиктограмме Plot.
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Блокировка слоев

 
Блокировку слоев полезно применять в случаях, когда требуется редактирование объек-

тов, расположенных на определенных слоях, с возможностью просмотра объектов на других
слоях. Редактировать объекты на заблокированных слоях нельзя. Однако они остаются види-
мыми, если слой включен и разморожен. Можно сделать заблокированный слой текущим и
создавать на нем объекты.

Допускается также применение на заблокированных слоях справочных команд к объек-
там и привязка к ним с помощью режимов объектной привязки. Заблокированные слои можно
включать и отключать, а также изменять связанные с ними цвета и типы линий.

Блокировка слоя включается либо в Диспетчере свойств слоев Layer Properties Manager,
показанном на рис. 5.1, либо в раскрывающемся списке управления слоями на панели инстру-
ментов Layers (см. рис. 5.2) щелчком на пиктограмме Lock соответствующего слоя.
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Цвет линии

 
Назначение объектам различных цветов облегчает работу с рисунком, поскольку позво-

ляет визуально идентифицировать группы объектов.
Присвоение цветов слоям осуществляется в Диспетчере свойств слоев Layer Properties

Manager, показанном на рис. 5.1. Для этого необходимо щелкнуть на пиктограмме Color соот-
ветствующего слоя. При этом загружается диалоговое окно Select Color, предлагающее выбрать
оттенок на палитре – рис. 5.3.

Рис. 5.3. Диалоговое окно выбора цвета

Можно ввести либо его имя, либо номер в виде целого числового значения от 1 до 255 в
таблице индексов цветов AutoCAD Color Index (ACI). Стандартные имена присвоены только
цветам с номерами от 1 до 7 (1 – красный, 2 – желтый, 3 – зеленый, 4 – голубой, 5 – синий,
6 – фиолетовый, 7 – белый/черный).

Полноцветная палитра цветов True Color располагает набором из 16 миллионов оттен-
ков. При этом используются две цветовые модели: RGB – где задаются красная, зеленая, и
синяя составляющие цвета, и HSL – где задаются оттенок, насыщенность и яркость цвета.

Цвета можно присваивать как слоям, так и отдельным объектам чертежа.
Кроме того, могут быть заданы ключевые слова ByLayer – по слою и ByBlock – по блоку.

ByLayer означает, что примитив будет создаваться в соответствии с цветом, определенным
для текущего слоя. ByBlock означает, что объекты будут изображаться белым цветом до тех
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пор, пока их не объединят в блок. Куда бы затем ни был вставлен блок, объекты приобретут
текущий цвет.

Интерес представляет работа с альбомами цветов – вкладка Color Books диалогового
окна Select Color (рис. 5.4), – которые содержат именованные образцы, что позволяет улучшить
вид рисунка и подготовить высококачественные презентационные материалы.

Рис. 5.4. Диалоговое окно альбомов цветов
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Тип линии

 
Применение различных типов линий – еще один способ визуального представления

информации. Различные типы линий отражают их разное назначение. Тип линии описывается
повторяющейся последовательностью штрихов, точек и пробелов. Линии сложных типов могут
включать в себя различные символы. Пользователь имеет возможность создавать собственные
типы линий.

Конкретные последовательности штрихов и точек, относительные длины штрихов и про-
белов, а также характеристики включаемых текстовых элементов и форм определяются име-
нем типа линии, а также его описанием.

Назначение типа линии слою осуществляется в Диспетчере свойств слоев Layer Properties
Manager. Для этого необходимо щелкнуть на пиктограмме Linetype соответствующего слоя. В
открывшемся диалоговом окне Select Linetype, показанном на рис. 5.5, выбирается подходя-
щий тип линии. Если в предлагаемом списке нет нужного варианта, следует подгрузить его,
щелкнув на кнопке Load… и указав в открывшемся диалоговом окне Load or Reload Linetypes
подходящий образец линии (рис. 5.6), затем, вернувшись в диалоговое окно Select Linetype,
установить указатель мыши на требуемый тип линии.

Рис. 5.5. Диалоговое окно установки типа линии
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Рис. 5.6. Диалоговое окно подгрузки различных типов линий

Ключевое слово ByLayer означает, что примитив будет создаваться в соответствии с
типом линии, определенным для текущего слоя. Ключевое слово ByBlock означает, что при-
митивы будут изображаться сплошными (continuous) линиями. Если эти объекты объединены
в блок, им присваивается тип линии, установленный для слоя, которому принадлежит точка
вставки блока.

Длина штрихов и пробелов, составляющих штрихпунктирную линию, измеряется в
условных единицах. Начальная установка масштаба типа линии для каждого рисунка – одна
единица. AutoCAD позволяет изменять масштаб изображения линии. Чем меньше масштаб,
тем больше повторений элементарного фрагмента линии.

Текущее значение глобального масштабного коэффициента для всех объектов хра-
нится в системной переменной LTSCALE. Значением масштаба текущего объекта управляет
системная переменная CELTSCALE, которая изменяет масштаб типа линий новых объектов.
Настройка масштаба типов линий на различных видовых экранах листа выполняется с помо-
щью системной переменной PSLTSCALE.

Для задания масштаба типов линий необходимо загрузить Диспетчер типов линий
Linetype Manager из падающего меню Format → Linetype… и щелкнуть на кнопке Show details
для включения подробного окна (рис. 5.7).
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Рис. 5.7. Диспетчер типов линий

В области Details приведены следующие параметры текущей линии:
• Name: – имя;
• Description: – пояснение;
• Use paper space units for scaling – масштаб в единицах пространства листа;
• Global scale factor: – глобальный масштаб;
• Current object scale: – текущий масштаб;
• ISO pen width: – толщина пера по ISO.
Имеется возможность переименовывать типы линий в любой момент редактирования

рисунка. Переименование какого-либо типа линии приводит к изменению его описания,
используемого в текущем рисунке. Название этого типа линии в библиотечном LIN-файле
остается прежним. Нельзя изменить имена типов линий ByLayer, ByBlock и Continuous, а также
типов линий, зависящих от внешних ссылок.

Типы линий можно сортировать по имени и описанию. При этом типы линий ByLayer и
ByBlock всегда находятся в начале списка. Названия типов линий могут быть отсортированы
в алфавитном порядке, как прямом, так и обратном.

Типы линий можно назначать любым объектам AutoCAD, кроме текстовых объектов,
точек, видовых экранов, бесконечных прямых, лучей, трехмерных полилиний и блоков. Если
длина объекта меньше длины элементарного фрагмента типа линии, такой объект отрисовы-
вается сплошной линией.

Для двумерной полилинии имеется возможность центрировать образец типа линии в
пределах каждого сегмента либо размещать образец непрерывно по всей ее длине. Управляет
этими режимами системная переменная PLINEGEN.
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Вес (толщина) линии

 
Веса линий определяют толщину начертания объектов и используются при выводе объек-

тов как на экран, так и на печать. Наличие линий различной толщины необходимо при оформ-
лении чертежей: для создания линий основного контура, размеров, штриховки, невидимых
линий и пр.

Для отображения на экране весов линий необходимо в строке состояния нажать кнопку
LWT.

Вес линии устанавливается в Диспетчере свойств слоев Layer Properties Manager (см. рис.
5.1). Для этого необходимо щелкнуть на пиктограмме Lineweight соответствующего слоя, а
затем в открывшемся диалоговом окне Lineweight выбрать из списка подходящее значение
(рис. 5.8).

Рис. 5.8. Диалоговое окно установки веса линии

Веса линий можно выбирать из определенного ряда значений, среди которых есть спе-
циальный вес под названием Default. По умолчанию вес линии Default соответствует толщине
0,25 мм (0,01 дюйма), это значение устанавливается системной переменной LWDEFAULT.

В пространстве модели нулевое значение веса линии соответствует линии толщиной один
пиксел, а при выводе на печать – наименьшей величине, обеспечиваемой используемым печа-
тающим устройством. Все объекты, вес линии которых не превышает 0,025 мм (0,01 дюйма),
отрисовываются в пространстве модели линией толщиной один пиксел. Значения весов линии,
вводимые в командной строке, округляются до ближайшей стандартной величины.
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Информация о весе линии сохраняется при экспорте рисунка в другие форматы и при
копировании объектов в буфер обмена. Выбрать единицы представления веса линий и задать
значение для веса Default можно в диалоговом окне Lineweight Settings, показанном на рис.
5.9. Для вызова этого окна необходимо либо щелкнуть правой кнопкой мыши на кнопке
LWT в строке состояния и выбрать пункт Settings… из контекстного меню, либо нажать
кнопку Lineweight Settings… на вкладке User Preferences диалогового окна Options, либо вве-
сти команду LWEIGHT.

Рис. 5.9. Диалоговое окно установки параметров весов линий

Единицы представления весов линий (миллиметры или дюймы), используемые при
создании новых объектов и слоев, устанавливает системная переменная LWUNITS.

Способы отображения весов линий в пространствах модели и листа несколько различа-
ются. В пространстве модели каждому значению веса линии соответствует конкретное число
пикселов, определяющих видимую на экране толщину линий. В пространстве листа видимая
на экране толщина начертания объекта устанавливается пропорциональной текущему коэффи-
циенту экранного увеличения. Использование в пространстве модели фиксированного числа
пикселов для каждого веса линии облегчает идентификацию объектов по их толщине при
любом коэффициенте экранного увеличения. При этом необходимо помнить, что в простран-
стве модели видимая толщина линий может не соответствовать их действительной толщине.
Значению веса линии 0 в пространстве модели всегда соответствует линия толщиной один
пиксел. Толщина отображения остальных весов линий (в пикселах) устанавливается пропор-
ционально их точным значениям.

В пространстве модели, когда включен режим отображения весов линий, в точках соеди-
нения концов отдельных отрезков используется соединение со скосом без окончаний линий.
При этом угол скоса подбирается автоматически. Окончания линий определяют способ изоб-
ражения концов отрезков и могут, например, представлять закругление или скос. При выводе
на печать с помощью стилей печатей можно задавать различные типы соединений и окончания
линий для различных весов линий.

В пространстве модели в режиме отображения весов линий, толщина начертания любого
объекта не зависит от коэффициента экранного увеличения. Например, если весу линии соот-
ветствует толщина четыре пиксела, то объекты с таким весом всегда отрисовываются линией
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толщиной четыре пиксела, даже при уменьшении экранного изображения до максимально воз-
можного значения.

Можно задавать масштаб отображения весов линий и изменять таким образом количе-
ство пикселов, соответствующих весам линий в пространстве модели. Изменение масштаба
отображения не влияет на толщину линий при выводе на печать. Следует отметить, что если
используемые веса линий представлены более чем одним пикселом, то время регенерации
рисунка возрастает. Если устанавливаемый по умолчанию масштаб отображения не изменялся,
то веса линий, меньшие или равные 0,025 мм (0,01 дюйма), отображаются толщиной один
пиксел и потому не снижают скорость работы AutoCAD. При изменении масштаба отображе-
ния весов линий количество весов, соответствующих толщине один пиксел, также изменяется.
Для повышения скорости работы AutoCAD в пространстве модели можно уменьшить масштаб
экранного отображения весов линий или вообще отключить веса линий.

Веса линий игнорируются для шрифтов True Type, растровых изображений, точек и
заливок для плоских фигур.
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Фильтрация слоев

 
Иногда требуется, чтобы в списке имеющихся слоев Диспетчера свойств слоев Layer

Properties Manager перечислялись только определенные слои. Для указания выводимых в спи-
сок слоев используется функция фильтрации. Фильтрация слоев может производиться по сле-
дующим критериям:

• по именам, цветам и типам линий, весам линий и стилям печати, назначенным слоям;
• по состояниям слоев «включен/отключен»;
• по состояниям слоев «заморожен/разморожен»;
• по состояниям слоев «блокирован/разблокирован»;
• по состояниям слоев «печатать/не печатать»;
• по наличию/отсутствию слоев в текущем рисунке;
• по наличию/отсутствию зависимостей слоев от внешних ссылок.
Инструменты, позволяющие настроить фильтры слоев, находятся в левом верхнем углу

Диспетчера свойств слоев Layer Properties Manager (см. рис. 5.1).

New Property Filter (Alt+P) – загрузка диалогового окна Layer Filter Properties, позволя-
ющего настроить новый фильтр слоев по свойствам (рис. 5.10).

Рис. 5.10. Диалоговое окно настройки свойств фильтра слоев

New Group Filter (Alt+G) – создание нового группового фильтра.
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Layer States Manager (Alt+S) – загрузка Диспетчера конфигураций слоев Layer States
Manager (рис. 5.11).

Рис. 5.11. Диспетчер конфигураций слоев

• В области Layer properties to restore определяются сохраняемые состояния слоев:
• On/Off – включен/отключен;
• Frozen/Thawed – заморожен/разморожен;
• Visibility in Current VP – видимость на текущем видовом экране;
• Locked/Unlocked – блокирован/разблокирован;
• Plot/No Plot – печатаемый/непечатаемый;
• Color – цвет;
• Linetype – тип линий;
• Lineweight – вес линий;
• Plot Style – стиль печати;
• New VP Frozen/Thawed – заморожен/разморожен на новых видовых экранах;
• Turn off layers not found in layer state – отключить слои, отсутствующие в конфигурации.
При щелчке правой кнопки мыши в левой области Диспетчера свойств слоев Layer

Properties Manager появляется контекстное меню (рис. 5.12), содержащее следующие пара-
метры:
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Рис. 5.12. Контекстное меню настройки фильтров

• Visibility – видимость (включить, отключить, разморозить, заморозить);
• Lock – блокировать/разблокировать;
• Viewport – видовой экран;
• Isolate Group – выделить группу (все видовые экраны, только активный видовой экран);
• New Properties Filter… – загрузка диалогового окна Layer Filter Properties, позволяю-

щего настроить новый фильтр слоев по свойствам (см. рис. 5.10);
• New Group Filter – новый групповой фильтр;
• Convert to Group Filter – преобразовать в групповой фильтр;
• Rename – переименовать;
• Delete – удалить;
• Properties… – загрузка палитры свойств объектов PROPERTIES.
При щелчке правой кнопки мыши в правой области Диспетчера свойств слоев Layer

Properties Manager появляется контекстное меню (рис. 5.13), содержащее следующие пара-
метры:
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Рис. 5.13. Контекстное меню Диспетчера свойств слоев

• Show Filter Tree – показать дерево фильтров;
• Show Filter in Layer List – показать фильтры в списке;
• Set current – установить;
• New Layer – новый слой;
• Rename Layer – переименовать слой;
• Delete Layer – удалить слой;
• Change Description – изменить пояснение;
• Remove From Group Filter – удалить из группового фильтра;
• New Layer VP Frozen All Viewports – создать новый замороженный слой на всех видовых

экранах;
• VP Freeze Layer in All Viewports – заморозить слой на всех видовых экранах;
• VP Thaw Layer in All Viewports – разморозить слой на всех видовых экранах;
• Select All – выбрать все;
• Clear All – очистить все;
• Select All but Current – выбрать все, кроме текущего;
• Invert Selection – инвертировать выбор;
• Invert Layer Filter – инвертировать фильтр;
• Layer Filters – фильтр слоев (все, все используемые слои);
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• Save Layer States… – загрузка диалогового окна сохранения новой конфигурации слоев
New Layer State to Save;

• Restore Layer State… – загрузка Диспетчера конфигураций слоев Layer States Manager
для восстановления конфигурации.
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Использование свойств слоев

 
Имеется возможность присваивать свойства как слоям, так и непосредственно объек-

там рисунка. При построении нового объекта ему автоматически назначаются цвет, тип и вес
линии, а также стиль печати ByLayer. Если свойство объекта имеет специальное значение
ByLayer, фактическое значение этого свойства определяется параметром того слоя, на котором
находится объект. Например, при построении на слое, которому назначены зеленый цвет, тип
линии Continuous, вес линии 0.25 mm и стиль печати Default, новый объект отображается с
использованием именно этих значений. Применение специального значения ByLayer, доступ-
ного для таких свойств объекта, как цвет, тип линии, вес линии и стиль печати, упрощает
управление и манипуляцию объектами рисунка. Кроме того, послойная организация чертежа
упрощает визуальную идентификацию различных его элементов (деталей, крепежа, текстовой
информации и т. д.) по свойствам слоев, на которых они располагаются.

Если необходимо, любому объекту можно присвоить цвет, тип линии, вес линии или
стиль печати, отличный от соответствующего свойства слоя, на котором располагается объект.
Свойство объекта может иметь какое-либо определенное значение (например, «красный» –
для цвета) или одно из специальных значений ByLayer либо ByBlock. Новое значение свойства
объекта используется вместо соответствующего свойства слоя до тех пор, пока этому свойству
не будет возвращено значение ByLayer.

При выборе значения ByBlock свойства новых объектов используют стандартные значе-
ния до тех пор, пока объекты не будут объединены в блок. После создания блока из таких
объектов значения их свойств определяются свойствами слоя, в который вставляется блок.

Рассмотрим пример: блок с именем СТУЛ образован из двух объектов, сиденья и спинки.
Исходные объекты, изображающие сиденье и спинку стула, находятся соответственно на слоях
СИДЕНЬЕ и СПИНКА. Пусть блок СТУЛ вставляется в слой с именем МЕБЕЛЬ, которому
назначен фиолетовый цвет. Если до создания блока объекты, соответствующие спинке и сиде-
нью, имели цвет ByLayer, то независимо от слоя, в который вставлен блок, цвет сиденья и
спинки будет определяться текущим значением цвета слоев СИДЕНЬЕ и СПИНКА. Если до
создания блока объекты, соответствующие спинке и сиденью, имели цвет ByBlock, то цвет
сиденья и спинки будет определяться текущим цветом того слоя, в который вставлен блок (в
данном случае это фиолетовый цвет).

Для быстрого просмотра и изменения цвета, типа линии и ее веса можно использовать
строку свойств объектов.

При выборе объекта, если ни одна из команд не активна, динамически отображаются
слой, цвет, тип и вес линии данного объекта. Параметры выбранного объекта можно изменить,
настроив их в раскрывающихся списках управления цветом, типом или весом линии, но при
этом не должна выполняться ни одна команда. Чтобы сделать цвет, тип или вес линии теку-
щими, достаточно выбрать их соответственно из раскрывающихся списков управления свой-
ствами линии.
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Копирование свойств объектов

 

Команда MATCHPROP предназначена для копирования свойств заданного объекта
другому объекту. Она вызывается из падающего меню Modify → Match Properties или щелчком
на пиктограмме Match Properties стандартной панели инструментов.

Допускается копировать цвет, слой, тип линий, масштаб типа линий, вес линий, стиль
печати, трехмерную высоту и другие свойства.

В процессе копирования свойств объектов можно изменять параметры настройки
свойств, например запретить копирование некоторых из них. Для этого необходимо щелкнуть
на пиктограмме Match Properties стандартной панели инструментов, выбрать объект, свойства
которого необходимо скопировать. Далее щелчком правой кнопки мыши вызвать контекстное
меню, из которого выбрать пункт Settings.

Загрузится диалоговое окно настройки свойств Property Settings (рис. 5.14), позволяю-
щее настроить следующие параметры.

Рис. 5.14. Диалоговое окно настройки свойств

• В области Basic Properties – определить основные свойства:
– Color – цвет;
– Layer – слой;
– Linetype – тип линии;
– Linetype Scale – масштаб типа линий;
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– Lineweight – вес линий;
– Thickness – высота;
– PlotStyle – стиль печати.
• В области Special Properties – определить специальные свойства:
– Dimension – размер;
– Polyline – полилиния;
– Material – материал;
– Text – текст;
– Viewport – видовой экран;
– Shadow display – отображение тени;
– Hatch – штриховка;
– Table – таблица;
– Multileader – линия-выноска.
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Палитра свойств объектов

 

Палитра свойств объектов PROPERTIES, показанная на рис. 5.15, – это единый инстру-
мент, управляющий практически всеми свойствами объектов рисунка. На палитре собрано
около 40 диалоговых окон и команд, которые были разрознены в более ранних версиях
AutoCAD. Загружается она командой PROPERTIES, либо из падающего меню Modify →
Properties, либо щелчком на пиктограмме Properties (Ctrl+1) на стандартной панели инстру-
ментов.
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Рис. 5.15. Палитра свойств объектов

Палитра свойств объектов Properties позволяет производить фильтрацию наборов
выбранных объектов по их типу, предоставляя возможность редактировать свойства каждого
объекта. В случае если текущий набор объектов не создан, показывается текущее состояние
таких свойств рисунка, как стиль вывода на печать, ПСК, данные о видовых экранах, гиперс-
сылки.
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В верхней части палитры расположен раскрывающийся список, содержащий типы и коли-
чество выбранных объектов. Справа от него – кнопки переключения Toggle value of PICKADD
Sysvar и выбора объектов Select Objects и Quick Select.

Ниже расположены следующие разделы.
• General – общие, содержит поля:
– Color – цвет;
– Layer – слой;
– Linetype – тип линий;
– Linetype scale – масштаб типа линий;
– Lineweight – вес линий;
– Thickness – высота.
• 3D Visualization – трехмерная визуализация, содержит поля:
– Material – материал;
– Shadow display – отображение тени.
• Plot style – стиль печати, содержит поля:
– Plot style – стиль печати;
– Plot style table – таблица стилей печати;
– Plot table attached to – пространство таблицы стилей печати;
– Plot table type – тип стилей печати.
• View – вид, содержит поля:
– Center X – центр X;
– Center Y – центр Y;
– Center Z – центр Z;
– Height – высота;
– Width – ширина.
• Misc – разное, содержит поля:
– Annotation scale – масштаб;
– UCS icon On – знак ПСК включен;
– UCS icon at origin – знак ПСК в начале координат;
– UCS per viewport – ПСК в каждом видовом экране;
– UCS Name – имя ПСК;
– Visual Style – визуальный стиль изображения.
Палитра свойств объектов Properties может оставаться открытой в процессе работы; она

показывает свойства выбранного объекта. Если выделено несколько объектов, в окне выво-
дятся только общие свойства, значения которых совпадают у всех выбранных объектов. К
общим свойствам относятся цвет, слой, тип линии, масштаб типа линии, стиль печати, вес
линии, гиперссылка, высота.
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Глава 6

Управление экраном
 

Зумирование
Панорамирование
Использование окна общего вида Aerial View
Перерисовка и регенерация
Изменение порядка рисования объектов

Система AutoCAD обладает широкими возможностями отображения различных видов
рисунка. Предусмотрены команды, которые позволяют при редактировании чертежа быстро
перемещаться от одного его фрагмента к другому для визуального контроля внесенных изме-
нений. Можно зумировать изображение, изменяя его экранное увеличение, или производить
панорамирование, перемещая рисунок по видовому экрану; также допускается сохранение
выбранного вида с его последующим восстановлением для вывода на печать или просмотра.
Кроме того, обеспечивается одновременный просмотр различных участков рисунка путем раз-
деления области рисунка на несколько неперекрывающихся видовых экранов.
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Зумирование

 
Видом называется совокупность экранного увеличения, положения и ориентации части

рисунка, видимой на экране. Основной способ изменения вида – выбор одного из имеющихся
в AutoCAD режимов зумирования, при котором размер изображения фрагмента в области
рисунка увеличивается или уменьшается.

При зумировании либо увеличивают изображение с целью большей детализации, либо
уменьшают для того, чтобы на экране помещалась большая часть рисунка (рис. 6.1, 6.2).

Рис. 6.1. Уменьшенное изображение рисунка

Рис. 6.2. Увеличенное изображение рисунка

При зумировании абсолютные размеры рисунка остаются прежними – изменяется лишь
размер его части, видимой в графической области. В AutoCAD существуют различные спо-
собы изменения вида, в том числе указание его границ рамкой, изменение коэффициента уве-
личения/уменьшения на заданную величину и показ рисунка в его границах.

Операция зумирования осуществляется командой ZOOM, вызываемой из падающего
меню View → Zoom, как показано на рис. 6.3, либо же со стандартной или плавающей панели
инструментов Zoom (рис. 6.4).
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Рис. 6.3. Команда зумирования в падающем меню
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Рис. 6.4. Команда зумирования на стандартной и плавающей панелях инструментов

Запрос команды ZOOM:
Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/

Dynamic/Extents/Previous/Scale/Window/Object] <real time>: – указать угол
рамки, ввести масштаб, или один из ключей (Все/Центр/Динамика/Границы/
Предыдущий/Масштаб/Рамка/Объект)

Команда ZOOM на стандартной панели инструментов имеет несколько исполнений.
Ниже приводится подробное описание каждого из них.

Zoom Realtime – увеличение и уменьшение масштаба изображения в режиме реального
времени.

Команда ZOOM с ключом real time обеспечивает возможность интерактивного зумиро-
вания изображения в режиме реального времени. При перемещении указателя мыши по видо-
вому экрану происходит динамическое увеличение или уменьшение выводимого на экране
рисунка.

Для активизации функции зумирования в реальном времени можно либо выбрать
команду из падающего меню View → Zoom → Realtime (см. рис. 6.3), либо щелкнуть на пикто-
грамме Zoom Realtime на стандартной панели инструментов (см. рис. 6.4), либо ввести слово
ZOOM в командной строке с ключом real time. Этот ключ используется по умолчанию при
вызове команды ZOOM. При нажатии клавиши Enter после ввода команды в командной строке
устанавливается режим зумирования в реальном времени.

В этом режиме пользователь может изменять экранное увеличение выводимого изобра-
жения, перемещая вверх или вниз по видовому экрану указатель мыши. Поместив его в сере-
дину изображения на экране и удерживая нажатой кнопку мыши, можно увеличить или умень-
шить изображение на 100 %, передвинув указатель соответственно в верхнюю или нижнюю
часть видового экрана.
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Если отпустить кнопку мыши, зумирование приостанавливается. Пользователь может
отпустить кнопку, переместить указатель в другую позицию на рисунке, а затем снова нажать,
чтобы продолжить зумирование в новой позиции.

Для выхода из режима зумирования можно использовать контекстное меню, выбрав в
нем пункт Enter, или нажать на клавиатуре клавишу Esc.

Если применяется функция предварительного просмотра печатаемого чертежа, то пре-
делы зумирования ограничены разрешающей способностью используемого плоттера. При уве-
личении изображения в окне предварительного просмотра операция зумирования прекра-
щается в тот момент, когда точка на экране в точности соответствует точке (или шагу)
используемого плоттера. Увеличение изображения при зумировании в окне предварительного
просмотра допускается только до тех пределов детализации изображения, которые может обес-
печить плоттер или принтер.

При достижении предела увеличения изображения на текущем виде символ «плюс» (+)
на указателе зумирования исчезает, что свидетельствует о невозможности дальнейшего зуми-
рования в данном направлении. Аналогичным образом при уменьшении рисунка до предела
(до границ текущего вида) на указателе зумирования исчезает символ «минус» (–). Еще больше
уменьшить рисунок после вывода границ текущего вида нельзя.

Zoom Window – определение области отображения с помощью рамки. Для активизации
функции зумирования рамкой необходимо выбрать команду из падающего меню View → Zoom
→ Window либо щелкнуть на пиктограмме Zoom Window на стандартной панели инструмен-
тов. После следует задать два противоположных угла прямоугольной рамки. При этом левый
нижний угол обозначенной рамки становится левым нижним углом нового вида. Форма нового
вида может несколько отличаться от формы рамки, так как при зумировании вид вписывается
в область рисунка. Команда ZOOM с ключом Window выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _w

Specify first corner: – указать первый угол окна
Specify opposite corner: – указать противоположный угол окна

Zoom Dynamic – динамическое определение области отображения. Вызывается из пада-
ющего меню View → Zoom → Dynamic либо щелчком на пиктограмме Zoom Dynamic на стан-
дартной панели инструментов. Используется для изменения вида без регенерации рисунка.
Команда ZOOM с ключом Dynamic отображает видимую часть рисунка в рамке, представля-
ющего текущий вид. Путем перемещения этой рамки и изменения ее размеров выполняются
зумирование и панорамирование рисунка. Видовое окно перемещается по рисунку при нажа-
той левой кнопке мыши; аналогичным способом изменяются и размеры окна. Видовое окно
можно передвигать по изображению, когда окно содержит символ Х, и изменять его размеры в
состоянии, когда имеется символ стрелки →. Переключение из одного состояния в другое осу-
ществляется щелчком левой кнопки мыши. При нажатии клавиши Enter изображение, заклю-
ченное в видовом окне, выводится на видовой экран. В зависимости от используемого видеомо-
нитора границы текущего вида обозначаются зеленой пунктирной линией, а границы рисунка –
синей. Границы рисунка в данном случае либо соответствуют лимитам рисунка, либо ограни-
чивают область, реально занимаемую изображением (если она выходит за пределы лимитов).
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Zoom Scale – установка масштабного коэффициента увеличения. Вызывается из пада-
ющего меню View → Zoom → Scale либо щелчком на пиктограмме Zoom Scale на стандартной
панели инструментов. Масштабирование вида используется в том случае, если изображение
требуется уменьшить или увеличить на точно заданную величину. При этом необходимо ука-
зать коэффициент экранного увеличения одним из трех способов:

• относительно лимитов рисунка;
• относительно текущего вида;
• относительно единиц пространства листа.
Команда ZOOM с ключом Scale выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _s

Enter a scale factor (nX or nXP): – указать масштабный коэффициент
Чтобы экранное увеличение было задано относительно лимитов рисунка, достаточно

лишь ввести значение коэффициента. Например, если это 1, то в графической области будет
располагаться рисунок в своих лимитах. Центр рисунка совпадает с центром предыдущего
вида. Для увеличения или уменьшения изображения следует указать соответственно большее
или меньшее значение коэффициента. Если ввести 2, изображение будет вдвое больше, чем
при коэффициенте 1, а если ввести 0.5 – вдвое меньше.

Для масштабирования вида относительно текущего нужно после значения коэффициента
добавить латинскую букву x. Так, для увеличения изображения текущего вида вдвое понадо-
бится ввести 2x, а для уменьшения вдвое – 0.5x. Ввод 1x не изменяет изображение.

Zoom Center – определение области изображения путем ввода точки центра и высоты
окна в единицах рисунка. Вызывается из падающего меню View → Zoom → Center либо щелч-
ком на пиктограмме Zoom Center на стандартной панели инструментов. Команда ZOOM с
ключом Center выдает следующие запросы:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _c

Specify center point: – указать центральную точку
Enter magnifi cation or height: – указать увеличение или высоту

Для указания высоты можно использовать абсолютное значение – число. При этом изме-
нение происходит относительно полного вида. Если требуется задать изменение масштаба
относительно текущего вида, за числом следует ввести латинскую букву x. При работе с плава-
ющими видовыми окнами для увеличения вида относительно пространства листа необходимо
ввести после числа латинские буквы xp.

Zoom Object – отображение области, которая содержит выбранные объекты. Вызывается
из падающего меню View → Zoom → Object либо щелчком на пиктограмме Zoom Object на
стандартной панели инструментов. Команда ZOOM с ключом Object производит вычисление
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коэффициента экранного увеличения с учетом границ, в которые вписан выбранный объект,
и выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window/Object] <real time>: _o

Select objects: – выбрать объекты

Zoom In – увеличение изображения. Вызывается из падающего меню View → Zoom → In
либо щелчком на пиктограмме Zoom In на стандартной панели инструментов. Команда ZOOM
с ключом 2x выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window/Object] <real time>: 2x

Zoom Out – уменьшение изображения. Вызывается из падающего меню View → Zoom →
Out либо щелчком на пиктограмме Zoom Out на стандартной панели инструментов. Команда
ZOOM с ключом .5x выдает следующие сообщения:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/
Dynamic/Extents/Previous/Scale/Window/Object] <real time>: .5x

Zoom All – отображение всей области чертежа или области внутри границ, если они
заданы. Вызывается из падающего меню View → Zoom → All либо щелчком на пиктограмме
Zoom All на стандартной панели инструментов. Команда ZOOM с ключом All позволяет уви-
деть на экране рисунок целиком. Если некоторые его объекты расположены вне лимитов, он
изображается в своих собственных границах. При этом происходит регенерация рисунка. Если
все объекты находятся в пределах лимитов, команда выводит чертеж в его лимитах. С помо-
щью данного метода удобно контролировать размещение объектов относительно области рисо-
вания.

Zoom Extents – отображение области, которая содержит все примитивы чертежа. Вызыва-
ется из падающего меню View → Zoom → Extents либо щелчком на пиктограмме Zoom Extents
на стандартной панели инструментов. Команда ZOOM с ключом Extents производит вычис-
ление коэффициента экранного увеличения с учетом границ текущего видового экрана, а не
текущего вида. Чаще всего видовой экран отображается полностью; в таком случае результат
работы функции очевиден и понятен. Однако, когда команда ZOOM используется в простран-
стве модели при работе в видовом экране пространства листа для зумирования за пределами
границ этого видового экрана, некоторая часть зумируемой области может остаться за преде-
лами видимости.
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Zoom Previous – использование предыдущего вида рисунка. Вызывается из падающего
меню View → Zoom → Previous либо щелчком на пиктограмме Zoom Previous на стандартной
панели инструментов. При работе с мелкими деталями часто возникает необходимость умень-
шить изображение, чтобы просмотреть сделанные изменения в общем виде. Для быстрого воз-
врата к предыдущему виду служит команда ZOOM с ключом Previous. Она восстанавливает
только экранное увеличение и положение вида, но не содержимое редактируемого рисунка.

Программа AutoCAD способна восстанавливать последовательно до 10 предыдущих
видов. В это число входят виды, полученные не только при зумировании, но и при панорами-
ровании, восстановлении и установке вида в перспективе или в плане.
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Панорамирование

 

Pan Realtime – панорамирование в реальном времени.
Команда PAN обеспечивает возможность интерактивного панорамирования изображе-

ния. При перемещении указателя мыши по видовому экрану происходит динамическое пере-
мещение изображения. Для активизации функции панорамирования в реальном времени
можно либо щелкнуть на кнопке Pan Realtime на стандартной панели инструментов, либо
выбрать команду из падающего меню View → Pan → Realtime.

Режим панорамирования в реальном времени используется по умолчанию при вызове
команды PAN.

Чтобы изменить положение изображения на видовом экране в режиме панорамирования
в реальном времени, следует перемещать указатель мыши, удерживая ее левую кнопку нажа-
той. Панорамирование может выполняться в одном направлении до тех пор, пока не потребу-
ется полная регенерация изображения или не будут достигнуты лимиты рисунка. В этом слу-
чае к изображению указателя панорамирования добавляется соответствующий направлению
символ-ограничитель.

Для выхода из режима панорамирования или переключения между режимами панорами-
рования и зумирования можно использовать контекстное меню; при этом необходимо нажать
клавишу Enter или Esc.
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Использование окна общего вида Aerial View

 
Команда DSVIEWER осуществляет вызов диалогового окна Aerial View, обеспечива-

ющего интерактивное управление экранным увеличением текущего видового экрана. Также
окно Aerial View, показанное на рис. 6.5, вызывается из падающего меню View → Aerial View. В
нем отображается общий вид рисунка и предоставляется возможность быстрого перемещения
в любую его часть. Если окно Aerial View открыто в ходе работы, можно производить панора-
мирование и зумирование, не используя меню или ввод команд.

Рис. 6.5. Окно общего вида

При каждой регенерации рисунка в AutoCAD происходит обновление содержимого вир-
туального экрана, то есть он очищается и заполняется заново. Окно Aerial View обеспечивает
возможность просмотра содержимого виртуального экрана AutoCAD.

Это окно работает со всеми видами пространства модели. Его легко отбуксировать в
любое место экрана. Изменение размеров окна производится при помощи буксировки границ.

Открыв окно Aerial View, можно оставить его видимым в ходе работы, а затем, когда
необходимость в нем отпадет, закрыть. Оно позволяет зумировать и панорамировать изобра-
жение в окне рисунка AutoCAD в реальном времени.

Зумирование вида может производиться путем создания в окне Aerial View новой рамки
вида. Для увеличения видимых размеров рисунка рамка должна быть меньше, для уменьше-
ния – больше. При создании или изменении размера рамки соответствующие изменения вида
параллельно отображаются в области рисунка.

Панорамирование рисунка выполняется путем перемещения рамки вида без изменения
ее размеров. При этом изменяется только вид – экранное увеличение остается прежним.
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Перерисовка и регенерация

 
Чтобы обновить изображение на экране монитора, его можно перерисовывать или реге-

нерировать. При регенерации, кроме перерисовки изображения текущего видового экрана,
производится пересчет экранных координат (преобразование значений с плавающей точкой
из базы данных в соответствующие целочисленные экранные координаты) всех объектов базы
данных рисунка. Таким образом, перерисовка происходит быстрее, чем регенерация.
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Конец ознакомительного фрагмента.
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